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1  Introduction

SmartPTT is  a  software  package  designed  to  manage  dispatch  communication  between  linear-extended  and

geographically-distributed objects where it  is  necessary  to facilitate voice and data transmission between remote

control stations of the radio network.

SmartPTT implements all benefits of the MOTOTRBO digital platform.

SmartPTT architecture  manages  subscriber  networks  of  any  size  and  topology,  using  both  digital  functions  of

MOTOTRBO  radio  stations  and  analog  mode  to  facilitate  a  gradual  upgrade  to  the  new  radio  communication

standard.  It  is  also possible to use a "mixed" mode when some sites  operate in the analog mode and others  in

the digital mode.

SmartPTT architecture consists of three segments:

Management segment (dispatcher network administrators)

Base  segment,  including  radioservers  connected  to  stationary  radios  (mobile  MOTOTRBO  stations  as
control stations) and repeaters.

User segment or subscribers (mobile and portable radios)

The  management  segment  implements  control  and  monitoring  functions  –  data  management  (telemetry,

telemechanics), human resources management and industrial process control – via access to the base segment.

The  dispatcher  has  either  full  or  partial  access  to  the  system  radioserver,  that  is  software  installed  on  PCs.

SmartPTT software enables various MOTOTRBO platform functions, which form the basis of the system.

Radioservers are linked to fixed stations,  which are control stations for the system ,  and repeaters.  All  repeaters

are  interconnected  via  IP  network  and  enable  subscriber  roaming  and  formation  of  a  common,  geographically

distributed communication network.  Communication zones can be both  adjacent  and  separated.  The  number  of

radioserver and dispatcher seats is unlimited.

The radioserver database stores  radio  station  pool  data.  When  the  MOTOTRBO  subscriber  digital  radio  station

enters the SmartPTT network coverage zone, it sends a request to the radioserver and,  in the event  of successful

authentication, it is registered automatically.
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Dispatch control over NAI Voice network
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Dispatch control over Connect Plus network

Using SmartPTT dispatchers can easily perform their daily  functions,  i.e.,  organize radio communication,  monitor

subscribers  and communicate data to subscribers.  As for radio subscribers,  they  can  take  advantage  of  all  the

features of MOTOTRBO radios. The number of subscribers per radioserver is unlimited.
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2  SmartPTT Dispatcher

2.1  SmartPTT Dispatcher Interface

SmartPTT Dispatcher interface can be divided into the following sections:

1. Main Menu which also contains Quick Launch Buttons.

2. Main Area

3. Information Bar

Main Menu

The Main Menu bar contains  options and commands which allow you to carry  out  the majority  of  the  functions

available in the application.

Quick Launch Buttons provide you a quick access to some functionality of the application. Currently,  there are 3

such buttons.
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 The Conference  Call  button opens the Conference  Call  window where  you  can  hold  conference  calls.

For more information about this function see Conference Calls.

 The  Telephone  Subscribers button  opens  the  Telephone  Subscribers  window  which  allows  you  to

make calls to telephone subscribers from SmartPTT Dispatcher.

 The  Dispatchers  button  opens  the  Dispatchers  window  which  allows  you  to  make  calls  to  external

dispatchers from SmartPTT Dispatcher.

There are also other menu items represented by an icon:

 The Settings button opens the Settings menu allows you to configure system parameters,  create special

rules, which will help you manage workers, connect external third-party devices and so on.

 The Help button opens the Help menu where  you  can  read  the  help  file,  learn  about  the  application  or

check for updates.

 The UI Layout Settings button is  very  useful as  it  allows  the  dispatcher  to  remember  the  layout  of  the

Main Area (the position of opened windows and panels). Thus, next time the dispatcher opens the application,  he

or she won't need to open the windows all  over again.  The dispatcher can simply  click  the this  button and select

the layout he or she used earlier. For more information see User Interface Layout.

 The Change  Operator button allows you to change the operator.  At  clicking on this  button the dispatch

console is restarted, and you can select another operator in the Authorization window.

Main Area

The Main Area is a central area of the application window and is used for opening functional windows and panels

when operating in the application.
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Information Bar

The  Information  Bar  was  designed  to  give  the  user  information  about  the  number  of  unread  messages,  the

selected subscriber,  the owner of the license and the application version.  Here you can also see a special icon

which notifies about the approaching license expiration date.

2.1.1  Change Layout

There is an ability to adjust the layout of the opened panels in the Main Area. In order to do that,  click  on the tab

of the opened panel,  drag it  to the location where you would like to place  it  and  release.  As  soon  as  you  start

dragging a panel, new icons appear on the screen. The icons represent a new location of the panel on the screen.



12SmartPTT Dispatcher Interface

Dispatch Console User GuideSmartPTT PLUS 8.7

The table displays description of the icons.

Icon Description

Appears inside a panel, which means that you can either place the panel in

any of the  four  positions  beside  the  panel  or  insert  it  as  a  tab  inside  the

panel.

The four standalone icons can be used to place the panel in any position of

the Main area outside any other panel.

2.2  Map
SmartPTT supports  different  maps,  like  Google  Map,  Open  Street  Map,  vector  maps  of  various  formats,  raster

maps, polish format maps. Together with many useful tools like showing and animating a track,  defining points  of

interest, maps provide the dispatcher with a better control over radio subscribers.

Polish Format Maps

To open a polish format  map,  expand the Map menu in the Main Menu  bar  of  SmartPTT Dispatcher  and  click

Map (Polish format). In the opened window select the map file in a MP format.

Google Map

To  open  the  Google  Map,  expand  the  Map  menu  in  the  Main  Menu  bar  of  SmartPTT  Dispatcher  and  click

Google Map.

Raster Map

To open a raster map,  expand the Map menu in the Main Menu bar of SmartPTT Dispatcher  and  click  Raster

map > Open map. In the opened window select the file in a MAP format.

To create a map based on a map image, see the Raster Map section.

INGIT Map

To work  with INGIT vector maps in SmartPTT Dispatcher,  the GWX ActiveX Control application (version 6.1),  the

registration key (HASP) and INGIT vector maps are required.
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Note: The GWX ActiveX Control software is designed to build INGIT vector maps into independent  applications as

a unit,  which provides mapping service as  a part  of these applications.  GWX ActiveX Control  is  purchased  once

and  then  allows  you  to  use  various  INGIT  vector  maps.  Each  map  must  be  purchased  separately.  See  the

purchase conditions on the INGIT company website (http://www.ingit.ru).

GWX ActiveX Control Installation

Follow these steps to install GWX ActiveX Control:

1. Run purchased disk with maps. Insert your HASP into the USB of PC.

2. Click Proceed with the installation of GWX Active-X Control.

3. Select GWX-6.1 ActiveX Control Installation.

4. In the license agreement window, click I Agree.

http://www.ingit.ru
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5. GWX ActiveX Control offers a wizard that will perform the HASP driver upgrade if necessary.

Note: To upgrade the HASP driver manually,  download the latest  HASP driver installer from the supplier site

and follow the instructions provided.

6. Continue  to  follow any  remaining  on-screen  instructions  to  install  the  software.  Select  the  installation

folder. It is recommended to use the default installation directory, or create a folder at  the root  of the other

local drive and name it GWX61.

7. Select  the  check  box  that  is  next  to  the  component  that  you  want  to  add.  Make  sure  the  GWX-6.1

ActiveX Control check box is selected.

8. Once the installation is over, run Register GWX ActiveX Control.

When GWX ActiveX Control is installed and the software components are registered, it is possible to work with the

maps, allowed by licenses embedded in HASP. HASP must be plugged into the USB of your PC.

http://sentinelcustomer.safenet-inc.com/sentineldownloads/?s=&c=End+User&p=HASP4&o=all&t=all
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To open an INGIT map,  expand the Map menu in the Main Menu bar of SmartPTT Dispatcher and  click  INGIT

Map. In the opened window select the map file in a CHART format.

Note: If the map failed to load, restart Register GWX ActiveX Control.

MapInfo Map

To set a MapInfo map for SmartPTT Dispatcher, expand the Map menu in the Main Menu bar and click  MapInfo

Map > Map Settings. In the Map Settings window click  Add and in the opened window select  a map layer – a

file  in  a  TAB  format.  You  can  add  multiple  TAB-files  and  determine  the  drawing  order  of  the  layers  using  the

arrows on the right. To delete a layer, select the TAB-file and click Delete.

Min.  Object  Size  to  Show  on  Map  (pixels)  –  minimum  size  of  the  object  displayed  on  the  map  in  pixels.

Affects the detail level of the displayed map.

Scale to Draw Layer : 1 : – scale factor for a layer.  The layer objects  will  not  appear on the map when you are

zoomed in or out beyond the specified scale.
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In the Map Description File field specify the path to the map file.  Click  Save  when you are finished.  The file will

be saved in a SPMAP format. To open the map right after you saved it, click Save and Open.

To open a MapInfo map, expand the Map menu in the Main Menu bar and click  MapInfo Map >  Open Map.  In

the opened window select the  file in a SPMAP format.

Open Street Map

To open the online Open Street Map, expand the Map menu in the Main Menu bar and click  Open Street map

> Open Online Map. 

To open the offline Open Street Map, expand the Map menu in the Main Menu bar and click Open Street Map >

Open Map from File. In the opened window select a map file in an OSM format.

To open the Open Street  Map from local server,  expand the Map menu in the Main Menu  bar  and  click  Open

Street  Map  >  Settings.  In  the  Data  Source  for  OpenStreetMap  Online  field  specify  the  path  to  the  local

server. If you want to get back to the default  address,  clear Data  Source  for OpenStreetMap Online  and click

OK. 

MapPoint Map

To  work  with  MapPoint  maps  in  SmartPTT Dispatcher,  you  must  first  install  Microsoft  MapPoint  on  this  PC.

Europe or North America version depends on required target coverage area.

Note:  All  versions  of  Microsoft  MapPoint  show a  simple  outline  map  of  the  world  when  zoomed  and  scrolled

outside of their target  coverage area.  National borders  and a large number of cities  are shown outside the target

coverage area.  For the target  coverage  area,  road  detail  and  internal  subdivisions  such  as  provinces,  parishes,

counties, states are shown.

To open a MapPoint map of Europe or North America, expand the Map menu in the Main Menu bar of SmartPTT

Dispatcher and click MapPoint Maps > MapPoint "Europe" or MapPoint "North America".

To open a MapPoint map file created in Microsoft MapPoint earlier, expand the Map menu in the Main Menu bar
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of SmartPTT Dispatcher and click  MapPoint Maps > Open MapPoint Map File.  In the  opened  window select

the map file in a PTM or PTT format.

How to Use Maps

To move the map press and hold the left  mouse button,  and move where necessary.  Or use arrow keys to move,

this is applicable to the offline map.

To zoom in scroll the mouse wheel forward. To zoom out scroll the mouse wheel back. You can also use the keys

"+" and "-" to zoom in and zoom out.

Online maps allow you to display the object address. To do this,  right-click  at  any place on the map – the object

address will be shown. This feature is supported by online maps only (Google Map and Open Street Map).

Offline maps provide more opportunities  for improvement.  Right-click  on the offline map.  At  that,  a context  menu

appears.

Using this menu you can:

1. Search on the map

2. Select elements to be labeled on the map:

Roads

Buildings

Labels

3. Change the map’s appearance:

Add or remove grid

Add or remove scale

Add or remove coordinates

Add or remove detail level
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4. Select the map's rendering type:

Anti-aliasing

Default

High quality

High speed

None
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2.2.1  Raster Map

To set raster map settings, expand the Map menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Raster Map. At that, the configuration window is displayed for creating geographic raster maps based on an

image.

To create a map, select the map image using the browse button .

On the selected map image mark  reference points  (crossroads,  places of interest,  etc.) with the  help  of  Google

Earth and calculate their coordinates. Coordinates are calculated in the following way:

Longitude and Latitude = Degree + ((Minute * 60) + Second) / 3600 (this s a conversion from degrees,  minutes

and seconds into normal values), where X and Y are corresponding coordinates (in pixels) on the image.

The longitude corresponds to the horizontal coordinate (X) and the latitude corresponds to the vertical coordinate
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(Y). The longitude value can range from -180 degrees (the most  distant  longitude to the west  from the Greenwich

Meridian set to 0) to +180 degrees (the most distant  longitude to the east  from the Greenwich Meridian).  In fact  -

180 degrees and +180 degrees are the same longitude. The latitude value can range from -90 degrees (the South

Pole) to +90 degrees (the North Pole).

Longitude and Latitude coordinates,  already converted into normal  values  and  corresponding  to  the  subscriber's

current locations, are also shown in the subscriber's Call Window.

You need four points. Point selection criteria are:

Point 1 is located as close as possible to the top left image corner.

Point 2 is located as close as possible to the top right image corner.

Point 3 is located as close as possible to the bottom left image corner.

Point 4 is located as close as possible to the bottom right image corner.

After all coordinates are entered, click Finish. In the opened window set the raster map name and click Save.

To edit  or check object  locations in the  created  raster  map,  click  Open.  Locate  the  raster  map  in  the  window

which is displayed.

Note: The created raster map files and the image map file must be in the same folder.

2.2.2  Raster Maps From Database

SmartPTT Dispatcher allows you to work with large raster offline maps with a size of more than 5000х5000 pixels.

The functionality is used for displaying SmartPTT system objects located at a long distance from each other.  This

is achieved by dividing the original raster image into pieces and storing them in the database.
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To create the database for the raster map, send your query  to our technical support  service and attach the raster

map image in a JPEG format  with the list  of geographical positions on the map (e.g.,  in a  TXT or  MAP  format).

Geographical  positions  are  necessary  to  anchor  image  points  to  the  geographical  coordinates.  The  list  of

geographical  positions  must  contain  four  points  at  the  corners  of  the  map.  In  response  to  your  request  our

technical support specialist will provide you the database backup of the map in a BAK format.

Note: If the attachment(s) size exceeds the limit of 50 MB, split the file to several small files  using the archiver or

file  manager,  or  upload  it  to  the  file  hosting  service.  In  the  latter  case  include  a  link  to  the  file  in  your  query

message.

Then restore the database from  the  received  backup.  For  more  information  see  How to  restore  from  SmartPTT

Dispatcher database backup.

After  the  database  is  restored,  expand  the  Map  menu  in  the  Main  Menu  bar  and  click  Raster  Map  From

Database. Click Scan Database in the opened window, and you will see a list of all  available maps stored in the

databases of the selected server (see Database Settings, the Database Server Name field).

http://support.smartptt.com/hc/en-us/requests/new
http://support.smartptt.com/hc/en-us/requests/new
http://support.smartptt.com/hc/en-us/requests/new
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Name – name of the map stored in the database.  To change the name of the map,  double-click  on the name in

the Name field and enter a new name.

Database – name of the database.

Show – if the check box is selected,  the map is  available in the Map menu.  To open the map,  expand the Map

menu and select the required map under Raster Maps From Database.

To remove the map from the list, select the map and click Delete. To save your changes,  click  Save.  If you want

to undo the last changes, click Cancel.

2.2.3  Indoor Tracking

Big  organizations  with  huge  premises  require  constant  control  over  their  employees'  displacement  inside

buildings. For this purpose Indoor Tracking system was implemented.  Indoor Tracking system allows getting data

from  special  beacons  and  transmitting  it  to  SmartPTT  Dispatcher  or  any  other  client  application  using  API.

Contact our technical support (http://support.smartptt.com/hc/en-us) for SmartPTT Client API documentation. 

Currently, SmartPTT system supports two products:

Kilchherr option boards (K-TERM 44) with special beacons (K-TERM 70IC Beacon Transmitter). 

Blufi option boards (RF800) with special beacons (Connect-RTLS RF800).

http://support.smartptt.com/hc/en-us
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Note: The Indoor Tracking feature is  available only  for radios  with  special  option  boards  (see  above).  Also,  it  is

necessary  to  configure  special  settings  in  SmartPTT  Radioserver  Configurator  and  SmartPTT  Dispatcher.  The

required  settings  for  SmartPTT  Radioserver  are  described  in  the  Indoor  Tracking  section  of  the  SmartPTT

Radioserver Configurator help file.  To enable Indoor support  for a radio subscriber in SmartPTT Dispatcher,  open

the Properties window of the radio subscriber and in the Location tab select Indoor Tracking.

 

To create a building plan, expand the Map menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Indoor Tracking > New. In the Floor Plan window you can create a plan of the building floor or of a multi-

storey building.
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Building Name – a name of the building plan.

To add a floor of a building,  click  the Add button.  To remove a floor of a building,  select  it  from the list  and click

Delete. To change the floor order inside the building, use the Up and Down buttons.

Floor – a name or an ordinal number of a floor in a building. To change the name of the floor,  double-click  the old

name in the Floor field and type a new value.

File Path – a path to the floor plan file. You can use a floor plan in a DWG format or a raster image.  To attach a

plan to the floor, click the  button and select the required file.

Note:  DWG  (DraWinG)  is  a  binary  file  format  used  for  storing  two  and  three  dimensional  design  data  and

metadata. It is the native format for several CAD packages including nanoCAD, AutoCAD, IntelliCAD.

Save – you can save the floor or the building plan changes to a SPLAN or SPLANX (archive) format.

To open a building plan,  expand the Map menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Indoor Tracking > Open. To control more than one building at the same time in SmartPTT Dispatcher,  you

can open several Indoor Tracking panels.
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Building Floor Plan

Save – you can save the building plan changes to a SPLAN or SPLANX file.

Save As – you can save a copy of the building plan with another name.

View  Mode  (2D  or  3D)  –  a  mapping  of  the  building  plan  in  a  two-  or  three-dimensional  form.  This  feature  is

available only for floor plans in a DWG format.

Add Beacon  –  you  can  add  a  beacon  to  the  building  plan.  In  the  Beacon  Settings window specify  Beacon

Number, which must  correspond to the Beacon ID,  specified in the beacon settings.  Place the new beacon on

the map by clicking the left mouse button. To remove the beacon from the plan, double-click on the beacon and in

the opened window click Delete.

Geofences – allows you to unite the existing beacons to control the radio subscriber's  moving about  the building.

These geofences are used in Indoor positioning rules. 

Routes – allows you to create routes for radio subscribers. These routes are used in Indoor positioning rules.

Edit Plan – opens the Floor Plan window that  allows you to change  the  floor  name,  the  floor  order  inside  the

building, or the floor plan file.

Grid Size – the grid size of the building plan. For building plans based on raster images,  the Grid Size  option is

not available.

Label Size – the size of the radio subscriber and beacon labels displayed on the building plan.

Beacons – select a color for a beacon label.

Radio Subscribers – select a color for a radio subscriber label.

Subscribers on Indoor Map –  a  list  of  radio  subscribers  who  support  the  Indoor  Tracking  feature.  Select  the

check box, to display the radio subscriber's label on the building plan.

Subscribers' tracks – here you can record tracks of radio subscribers  and watch them in real time,  or check old

records.  To watch the radio subscriber move about  the building,  click  Add Track.  In the opened window specify

the following parameters:

Subscriber – the name or radio ID of the radio subscriber.

Source – the radioserver whose data will be used for building a track. If the drop-down list  is  empty,  check

that Event log is created and activated in SmartPTT Radioserver Configurator.

Color – the color of the future subscriber's track.

Start Date – start time and date of the track record.  

End Date  –  end  time  and  date  of  the  track  record.  To  watch  the  radio  subscriber  moving  in  real  time,
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select Update in real time.

Show  All  – shows tracks of all  the radio subscribers  from the Subscribers on  Indoor  Map  list.  You  can  see

details of each track. To open Track details, click :

Clear All – removes all the track records displayed at the moment.

The following buttons allow user to control the way the building plan is displayed:

Button Description

Zooming up the marked area of the building plan. Click the button, then left-click on the

building plan and mark the necessary area.

Zooming up or zooming out the entire building plan. To zoom in, click the button and

withholding the button pressed move the mouse pointer up. To zoom out – move the

mouse pointer down. Also, use the wheel button to change the scale of the building

plan.

Moving the building plan. Click the button and withholding the button pressed relocate the

plan.

Fits  the scale  of  the  building  plan  to  the  size  of  the  Indoor  Tracking  Overview  Map

panel.

 Available only  for  three-dimensional  building  plans.  Allows  changing  the  angle  of  the  displayed

building plan.
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2.2.4  Geofences

Geofences help dispatchers  to  keep  an  eye  on  the  radio  subscribers.  A  dispatcher  can  define  the  area  of  the

geofence on his or her own and attach GPS rules to it.

To  add  the  geofence,  expand  the  Map  menu  in  the  Main  Menu  bar  of  SmartPTT  Dispatcher  and  click

Geofences.  In the opened window you can add a new geofence or modify  settings of the existing  one  –  name,

color, and whether it should be displayed on the map:

Name – the geofence name.

Color – the geofence color on the map.

Show – enables the option to display the geofence on the map.

Note:  Whether  the  geofence  is  displayed  on  the  map  or  not,  GPS  rules  set  for  the  geofence  are  enabled.  To

assign a rule to the geofence, go to GPS Rules.

Add the zone-forming points of the new zone.  To do that,  click  Add in the Geofences window. To edit  the zone-

forming points, select the zone and click Edit.
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Specify a pair of longitude and latitude values for a zone-forming point.  To edit  point  coordinates,  place the cursor

into the required field and type new value. You can't create a zone with less than 3 longitude and latitude pairs.  To

delete the points, click Delete.

To delete a geofence from the list, select the geofence and click Delete.

You can also create a geofence from the Tools menu. For more information see Geofences panel.

Geofence Import

SmartPTT Dispatcher  allows  you  to  import  geofences  created  on  maps  in  Polish  format  with  the  help  of  the

GPSMapEdit software.

To create a geofence in GPSMapEdit:

1. Run the GPSMapEdit application.

2. Open a map in Polish format (File > Open).

3. Create a polygon object on the map. To do that, click Tools > Create Object > Polygon: Rectangle.

4. Left-click on the map at the start point of the new zone.  Then,  clicking the left  mouse add all  the required

points. Once you have a zone set up, the Select Type window opens.

5. In the Select Type window type the 0x99 value in the Code field and click OK.
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6. Type the zone name in the field on the map and press Enter.

7. Save your changes (File > Save).

To import geofences created on a maps in Polish format with the help of GPSMapEdit to SmartPTT Dispatcher:

1. Open the Geofences window (Map > Geofences).

2. Click Import.

3. Select the map in Polish format, which geofences will be imported.

4. Select geofences you want to import in the Import Geofences From Polish Map Format File window.

5. To see the imported geofence, make it active in the Geofences window.

2.2.5  Points of Interest

Points of interest (POI) identify location of special interest which are shown on the map and can be quickly  found

in SmartPTT Dispatcher. A point of interest consists of the point name, location coordinates and the picture.

To add a point of interest, expand the Map menu in the Main Menu bar of SmartPTT Dispatcher and click  Points

of Interest.

The Points of Interest window allows  you  to  change  the  name  of  the  existing  point  of  interest  and  whether  it
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should be displayed on the map.  To modify  the existing point  of interest,  select  it  and  click  Edit.  To  delete  the

point of interest, select it and click Delete.

To add a new point of interest, click Add.

Name – name of the point of interest.

Latitude – latitude coordinate of the point of interest.

Longitude – longitude coordinate of the point of interest.

Picture  –  the  image  which  represents  the  point  of  interest  on  the  map.  Maximum  image  size  of  the  point  of
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interest is 64×64 pixels. Images of the bigger size are be automatically cropped to 64×64.

Show on Map – enables the option to display the point of interest on the map.

You can also create a point of interest from the Tools menu. For more information see Points of Interest panel.

2.2.6  Routes

The  route  is  a  polyline  connecting  key  points  of  the  network  coverage  area.  Subscriber  location  near  the  key

points is identified by the specified radius of the route and can be summarized in the Subscriber Location Report.

To  specify  the  route  parameters  (Color,  Radius,  Coordinates),  expand  the  Map  menu  in  the  Main  Menu  of

SmartPTT Dispatcher and click Routes. In the opened window you can add a new route or modify  settings of the

existing one.

Name – the route name.

Color – the route color on the map.

Radius – the allowed deviation from the route.

Show – enables the option to display the route on the map.

To add a new route, click Add. To modify route settings, select a route from the list and click Edit.

In the Route Coordinates window specify the route name, the route line color,  the acceptable deviation from the

route for the radio subscriber, coordinates of the route points and its properties. Key Point is used for singling out
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particular places of the track on the map. You can give a name to each key point to be displayed on the map.  The

key points are represented by small white squares on the map. Select Show on Map to display  the route on the

map.

To delete the route, select it from the list and click Delete.

The route example:
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You can also create a route from the Tools menu. For more information see Routes panel.

2.2.7  Show Track

GPS tracking is very helpful for seeing the real-time position of the radio subscribers  you are tracking.  In addition,

the Show Track feature allows dispatcher quickly see where a radio subscriber was over a particular time frame.

Note: By default, GPS coordinates are not saved in the database. If you want  to save GPS coordinates,  open the

GPS Settings window in the Settings menu and select Save GPS Locations in Database.
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To specify draw parameters of the track,  expand the Map menu in the Main Menu of SmartPTT Dispatcher and

click Show track. The Track Draw Parameters window opens.

Source  – defines the source,  which database will  be  used  for  drawing  the  track.  If  Dispatcher  is  selected,  the

data is taken from the local database.  Apart  from Dispatcher,  any available radioserver can be chosen as a data

source. In that case all data is taken from the database of the chosen radioserver.

Subscriber – defines subscriber whose track is to be displayed.

Color – the track color on the map.

Line Thickness – thickness of the track line on the map.

Start Date, End Date – the time frame of the track.

2.2.8  Animate Track

To animate displayed tracks,  expand the Map menu in  the  Main  Menu  bar  of  SmartPTT Dispatcher  and  click

Animate Track.
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The Track Animation window opens.

Run track animation

Stop track animation

Pause

Run track animation slower

Run track animation faster

During track  animation you can slow it  down or make it  faster.  The system remembers  the last  track  animation

speed and uses it during next track animation. 
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Here is an image of a sample track on the map.

To clear the tracks shown on the current map, expand the Map menu in the Main Menu of SmartPTT Dispatcher

and click Clear Shown Tracks.

To clear the shown tracks on all  maps,  expand the Map menu in the Main Menu of  SmartPTT Dispatcher  and

click Clear Shown Tracks on All Maps.
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2.2.9  Coverage Map

Coverage maps give you information about RSSI of a particular radio in a particular place.

To compose a coverage map,  expand the Map menu in the Main Menu bar  of  SmartPTT Dispatcher  and  click

Show Coverage Map.

Source  – defines the source,  which database will  be  used  for  drawing  the  track.  If  Dispatcher  is  selected,  the

data is taken from the local database.  Apart  from Dispatcher,  any available radioserver can be chosen as a data

source. In that case all data is taken from the database of the chosen radioserver.

Subscriber – defines radio subscriber for whom the coverage map is  to be generated.  The list  of subscribers  is

taken from the connected database.

Note:  Click  Select  All  to  generate  a  coverage  map  for  all  subscribers  which  have  GPS  coordinates  in  the

database.

Grid – the radius value for checking RSSI.

Start Date, End Date – the time frame of the events.
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The coverage map example

The Legend box identifies the colors used in the coverage map.

To clean the map, select Hide Coverage Map in the Map menu.

2.3  Event Log
The Events window allows you to see what  is  going on in the system. The event  log  displays  status  and  event

messages from SmartPTT system, and other useful information.

To open the event log, click Event Log in the Main Menu bar and then All  Events.  To tune Event Log settings,

see Event Log.
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You can limit the number of displayed data by setting a period of time.  To do this,  click  Events for Period in the

Events menu. The Date/Time Period dialog is displayed.  Specify  start  and end date for entries  displayed in the

log.

To display only not read messages in the log, select Unread Messages.

The system event log appears as follows.

The log consists of the following columns:  Direction,  Event  Type,  Date/Time,  Radioserver,  Description,  Not  Read,

Operator,  Control  Station,  Subscriber,  Talkgroup,  Status,  Duration,  Record,  Connection  Type,  Repeater  IP  and
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Receiver,  Lone Worker.  By default,  all  the columns are displayed in the log.  To select  columns displayed in the

event log, right-click on the menu with column names and select the requisite columns in the list.

Place the cursor on the column name and click the arrow button  that appears to open a list of filters related to

the selected column. The following table contains a list of filters for the log columns and their description.

Column Name Filters Description

Direction
Left arrow

Right arrow

Direction  of  calls,  incoming  and

outgoing

Type

Block radio

Call

Registration

Message

Status

Telemetry

Alarm

Job Ticket

Lone Worker

Select  available  events  in

SmartPTT

Date/Time Date/Time A list  of filters  by  date/time  when



42Event Log

Dispatch Console User GuideSmartPTT PLUS 8.7

Column Name Filters Description

an event took place

Additional Information
Text from the Additional

Information or Message fields

Additional information includes:

text messages, titles and

description of tasks, initiators

and contributors of a group call,

and other.

Not Read Read
Select  read  and  not  read

messages

Operator Operators list List of SmartPTT operators

Radioserver List of radioservers
List  of  available  SmartPTT

radioservers

Channel List of channels
List  of  available  channels  in  the

system

Subscriber Subscribers list List of SmartPTT subscribers

Talkgroup List of talkgroups List of SmartPTT talkgroups

Status List of statuses List of SmartPTT statuses

Duration Timing list Displays for how long events last

Record
Not recorded

Recorded

Select  messages  with  and

without recorded audio files

Connection Type

IP

PBX

DMR

Connect+

Connection types in SmartPTT

Repeater IP Address list of repeaters
IP-address and port  of repeater in

IP Site Connect network

Receiver List of radios or talkgroups ID of receiving radio or talkgroup

Lone Worker Yes/No
Lone worker profile is  assigned to

the radio subscriber or not.

Note Text from the Note field Any text information added by
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Column Name Filters Description

the dispatcher

Note:  You can filter the event  log by  the column Not Read not  only  from the event  log,  but  also  by  clicking  on

"There are unread messages: n" in the Information bar.

Click  on  any  column  name  so  the  log  sorts  its  contents  according  to  this  column  content.  You  can  filter  the

content displayed in the log using filters.
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To group the log entries, click on the column title and drag it to the area labeled as  "Move column header here for

grouping".

If  you  want  to  have  particular  columns  to  be  always  seen  in  the  log  regardless  of  the  scroll  position,  use  the

special element in the column titles. Just drag it after the column you want to be always there.

To listen to audio records of the calls, select the call in the event log and click the Play Selected Records button

. 

Note: To enable recording of calls, go to Settings and select Records. There select Record Calls.
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The Play Records window for selected records opens.

Note:  After the record playback window opens,  selected records are reproduced automatically,  starting  from  the

earliest date.
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Player buttons:

 Start Playback plays the selected record and all the records of the list without stopping. 

 Pause  Playback  pauses  playback  of  the  current  record.  Clicking  the  Start  Playback  button  resumes

playback of the record from the place of suspension.

 Stop Playback stops playback of the current record. Clicking the Start Playback button enables  playback

of the record from the beginning.

 Return to Previous Record plays the previous record after the current one.

 Go to Next Record plays the following record after the current one.

Settings:

 Play  All  Records enables  the  mode  of  all  records  reproduction  in  turn.  Playback  is  controlled  by  the

previously described buttons.

 Replay enables  the mode of replaying the current  record or all  the records in turn if the Play All  Records

mode is activated.

Button  opens a subscriber call window. Button  opens a window for message sending. 

Opening Radioserver Event Log

Depending on SmartPTT system  configuration  the  event  log  can  be  saved  either  on  the  dispatcher  side  or  the

server side, or both. 



47Event Log

Dispatch Console User GuideSmartPTT PLUS 8.7

To open the event log saved at the radioserver:

1. Open the radioserver Action List and select Show Radioserver Event Log.

2. Select the Start and End Dates to show events of the period. The Radioserver Event Log is displayed in
the same way as the Dispatcher Event Log in a separate tab.

To make subscriber radio activity  report  based on the radioserver data,  select  Create  Radio Activity Report.  In

the opened window specify the period of time, grouping, a file to save the report and click OK.

2.4  Tools
From the Tools menu you can open all the panels used in SmartPTT Dispatcher. 

These are the following panels:

Calls panel displays the ongoing call activity and call history in the radio network.

Sound Spectrum panel allows you to monitor and adjust the signal volume.

Cross  Patches  panel  allows  you  to  connect  talkgroups  from  different  frequency  bands  or  from  different

network types dynamically.

Radio Fleet panel displays a list of radio subscribers registered in the system.

Subscribers panel for quick access to the subscribers.

Job Tickets panel from where you can create and supervise job tickets.

Sound Panel from where you can manage the sound volume of the selected subscribers and slots.

Lone Workers panel to show lone workers' status, for example,  that  a lone worker did not  call  for a longer

period than expected, etc.

Latest Incoming Calls panel, which gives you information of the recent voice calls made.

Notifications panel to get information about the alarms configured by the dispatcher.

System Messages panel, which displays errors, disconnection of the radioserver, etc.

Server Tasks panel to display server tasks in the background
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Map  Tools  contains  all  the  available  map  tools  of  the  dispatch  console:  Points  of  Interest,  Routes,

Geofences, Subscriber Location panels.

Custom Сonsole panel created by  the SmartPTT dispatcher to manage subscribers,  talkgroups or control

stations.

2.4.1  Calls

The Calls panel displays the ongoing call activity and call history in the radio network.

The first time you install SmartPTT, the Calls panel opens automatically. The panel can also be opened or closed

manually.  To do this,  expand the Tools menu in  the  Main  Menu  bar  of  the  SmartPTT Dispatcher  window and

click Calls.
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A call record in the Calls section contains several elements.

From this panel the dispatcher can do the following:

answer the ongoing call by clicking anywhere on the call record;

see the ongoing call activity. The call status can be determined by the color of the call record.

see history of all registered calls, time of call and its duration;

make all types of call by clicking on the button with the subscriber name. 

Call status is determined by the color of the call record:

1. Light yellow – outgoing call attempt or, a call in the queue (in conventional systems);

2. Yellow – outgoing call from SmartPTT Dispatcher to the to radio subscriber;

3. Green – incoming call to SmartPTT Dispatcher or radio monitoring;

4. Blue  –  none  of  the  parties  transmit  or  receive  voice  (hang  time).  The  subscriber  or  the  dispatcher  can

continue the call  by  pressing the PTT button within hang time.  After the hang time expires,  pressing  the

PTT button will initiate a new call.

If the Calls section is  empty,  to make a call  to a radio subscriber,  select  the subscriber under Radio Fleet and

click the PTT button. The correspondent call record will appear in the Calls section and the call will be initiated.

2.4.2  Sound Spectrum

The Sound Spectrum panel allows you to monitor and adjust the signal volume.

To open Sound Spectrum  panel,  expand the Tools menu in  the  Main  Menu  bar  of  the  SmartPTT Dispatcher
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window and click Sound Spectrum.

The  button allows you to adjust the speaker volume. The  button allows you to adjust  the microphone

volume.

2.4.3  Cross Patches

Cross Patches allow you to connect talkgroups from different frequency bands or from different network types very

quickly. A call made to a talkgroup that is included in the cross patch will be heard by all participants of this cross

patch (this is true even for a call made by the dispatcher).

A cross patch is  created in the dispatch console and controlled by  the  dispatcher.  When  the  dispatch  console

gets closed, all the cross patches created in this dispatch console will be saved. 

To create a cross patch, do the following:

1. Open the Cross Patches panel from the Tools menu (if it's not open).

2. Add a cross patch. To do this, in the Cross Patch panel click on the Add Cross Patch button:
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3. In the new Cross Patch window select  objects  of  the  future  cross  patch.  To  add  the  selected  object  to  the

cross patch or to remove it from the cross patch,  click  the corresponding arrows or double-click  on the mouse

button. Then click Enable.
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The new cross patch will appear in the Cross Patches panel.

In the Cross Patches panel you can do the following:

Filter the list of cross patches to see active cross patches or all cross patches (the Active and All options).

Make a call to all the parties of the cross patch by clicking on the PTT button.

Perform actions from the Actions List of the cross patch: enable or disable the cross patch,  edit  its  properties,
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mute or unmute it, and delete it from the list. To open the Actions List, click :

Enable / Disable – turns on/off the cross patch.

Mute  /  Unmute  –  turns  on/off  the  sound  for  all  parties  of  the  cross  patch.  If  the  cross  patch  is  muted,  the

dispatcher won't hear any party, but all the cross patch participants  will  hear the dispatcher.  If the cross patch is

unmuted,  but  one  of  the  participant  talkgroups  is  muted,  the  dispatcher  will  hear  all  the  others,  but  not  this

talkgroup.

2.4.4  Radio Fleet

The Radio Fleet panel displays a list of radio subscribers registered in the system.

The first time you install SmartPTT the Radio Fleet panel opens automatically. To open or close the Radio Fleet

panel manually,  expand the Tools menu in the  Main  Menu  bar  of  the  SmartPTT Dispatcher  window and  click

Radio Fleet.

The radio subscriber list consists  of the following columns – object,  status  and the PTT button.  The Object field

shows  the  name  of  the  subscriber  or  radioserver.  The  Status  field  displays  the  current  status  of  the  radio

subscriber. The PTT button initiates a call.
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To  edit  the  list  of  subscribers,  use  the   buttons.  You  can  show  or  hide

talkgroups, show or hide online or offline radio subscribers. Also, you can 

filter radio subscribers  by  the categories.  To do that,  click  Filter by category .  To filter radio subscribers

by the channels, click Filter by channel .

The entry  field under the  buttons allows you to  search  a  radio  subscriber  by

name or ID.

To filter the radio subscribers  by  a status,  click  the  button and select  the required status  form

the list.

The  and  allows the dispatcher to add a new radio subscriber or delete the existing subscriber.

Radio subscribers  not  added in SmartPTT Dispatcher are considered  unregistered  and  displayed  in  italic  in  the

Radio Fleet panel. Unregistered subscribers are displayed in the list of subscribers after a radio is  turned on and

registration on the radioserver is successfully completed.
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 — GPS coordinates of a radio subscriber are outdated or missing.

 — GPS coordinates of a radio subscriber are relevant. Relevance period of GPS coordinates  is  defined by  the

Relevancy of GPS coordinates parameter in Settings > Positioning Systems. 

Note:  and are displayed, if GPS support is enabled in the Properties window of a radio subscriber,  and at

least one location update criterion is selected.

Actions List

The  button opens the Actions List including a list  of actions which can be applied to a radio subscriber,  the

radioserver, a control station or a talkgroup. 



56Tools

Dispatch Console User GuideSmartPTT PLUS 8.7

The Actions List of the radioserver

Show  Radioserver Event  Log  –  displays  the  radioserver  event  log  for  the  specified  period  of  time.  For  more

information on the event log see Radioserver Event Log.

Configure Call Bridging Table – redirects to the routing configuration window.

Main Device  – shows what  audio  output  device  is  currently  used  for  the  radioserver.  You  can  also  change  to

another device.

View Properties – opens the radioservers's Properties window.

The Actions List of a hardware control station
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Exit Emergency Mode – disables emergency mode.

Note: The Exit Emergency Mode action becomes available after a radio subscriber sends the emergency signal.

Radio  Dekey  –  forced  interruption  of  calls  on  the  channel.  This  option  is  available  only  for  hardware  control

stations and in IP Site Connect network.

Reset Control Station – resets the control station. Only hardware control stations can be reset.

Mute / Unmute – turns off/on the control station mute mode.

Mute Others – leaves sound on only for this control station; other control stations are muted. 

Main Device  – shows what  audio  output  device  is  currently  used  for  the  control  station.To  change  to  another

device,  select  a specific  output  device or Inherited device,  i.e.,  the device selected for the  higher  level,  in  this

case, for the radioserver.

View Properties – opens the control stations's Properties window.

The Actions List of a virtual control station
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Radio  Dekey  –  forced  interruption  of  calls  on  the  channel.  This  option  is  available  only  for  hardware  control

stations and in IP Site Connect network.

Reset Control Station – resets the control station. Only hardware control stations can be reset.

Mute / Unmute – turns off/on the control station mute mode.

Mute Others – leaves sound on only for this control station; other control stations are muted.

Main Device  – shows what  audio output  device is  currently  used  for  the  control  station.To  change  to  another,

select a specific output  device or Inherited device,  i.e.  the device selected for the higher level,  in this  case,  for

the radioserver.

View Properties – opens the Properties window of the slot.
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The Actions List of a talkgroup

Exit Emergency Mode – disables emergency mode. The Exit Emergency Mode  action becomes available only

after a radio subscriber has sent the emergency signal.

Send Message – opens a window for creating and sending messages.

Make Conference Call – opens the Conference Call window and starts the conference call.

Call Telephone Subscriber – opens the window with the list of registered telephone subscribers.

Mute / Unmute – turns on/off mute mode for this group.

Main Device – shows what audio output device is  currently  used for the talkgroup.  To change to another device,

select a specific output device or Inherited device,  i.e.,  the device selected for the higher level,  in this  case,  for

the slot.

The Call Window  of a talkgroup contains  the same list  of actions.  The main function of the Call  Window  is  to

give the ability  to apply  actions to the talkgroup and to view the action log.  To open the window, double-click  on

the talkgroup.

View Properties – opens the Properties window of a talkgroup.

The Actions List of a radio subscriber
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Exit Emergency Mode – disables emergency mode. The Exit Emergency Mode  action becomes available after

a radio subscriber sends the emergency signal.

Send Message – opens a window for creating and sending messages.

Send Call Alert – sends a call alert to the subscriber.

Radio Check – sends the radio check command to the subscriber radio.

Monitoring – allows you to listen to the radio subscribers without their awareness.

Set Location – allows you to define location of the radio subscriber on the map manually,  without  GPS data.  If

GPS  support  is  enabled  in  the  radio  subscriber's  Properties  window  (in  the  Location  tab),  the  location  set

manually  has  a  validity  period  which  is  defined  in  the  Positioning  Systems settings  in  the  Validity  of  GPS

coordinates field.  If GPS support  is  not  enabled  in  the  radio  subscriber's  Properties window,  the  location  set

manually is always valid.

Find on Map – shows the subscriber on the map. If there are more than one subscriber on the same position on

the map, the subscriber's label will placed above all other labels.

Show Address – displays the subscriber address based on the current GPS coordinates.  When you reopen Call

Window (after it was closed), previously received information on the address is not displayed.

Remove from Map – removes the subscriber from the map.

Find on Indoor Plan – shows the subscriber on the building map.  The Find on Indoor Plan action is  available

for  a  radio  subscriber  if  the  Indoor  Tracking  check  box  is  selected  in  the  Properties  window  of  the  radio



62Tools

Dispatch Console User GuideSmartPTT PLUS 8.7

subscriber.

Block Radio – sends the Block Radio command to the subscriber radio.

Unblock Radio – send s the Unlock Radio command to the subscriber radio.

Make Conference Call – opens the Conference Call window and starts the conference call.

Call Telephone Subscriber – opens the window with the list of registered telephone subscribers.

Create  Point of Interest – creates  POI at  the current  place  of  the  subscriber.  If  there  are  no  coordinates,  the

system uses the latest coordinates received from the radio. If coordinates are absent altogether, nothing happens.

Create Deferred Action – opens a window for creation of a deferred action.

Main Device – shows what audio output  device is  currently  used for this  radio subscriber.  To change to another

device,  select  a specific  output  device or Inherited device,  i.e.,  the device selected for the  higher  level,  in  this

case, for the talkgroup.

View Properties – opens the subscriber's Properties window.

The Actions List of a mobile device subscriber
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Send Message – opens a window for creating and sending messages.

Set Location – allows you to define location of the mobile device on the map manually,  without  GPS data.  If

GPS  support  is  enabled  in  the  mobile  device's  Properties window (in  the  Location  tab),  the  location  set
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manually  has a validity  period which is  defined in the Positioning Systems settings in  the  Validity  of  GPS

coordinates field.  If GPS support  is  not  enabled in the mobile  device's  Properties window,  the  location  set

manually is always valid.

Find on Map – shows the device on the map.  If there are more than one  device  or  subscriber  on  the  same

position on the map, the device's label will placed above all other labels.

Show Address – displays the device address based on the current  GPS coordinates.  When you reopen Call

Window (after it was closed), previously received information on the address is not displayed.

Remove from map – removes the device from the map.

View Properties - opens the device's Properties window.

Call Window

The Call Window of a radio subscriber contains the same list of actions.  The main function of the Call  Window

is to give the ability to apply actions to the subscriber and to view the action log. To open the window, double-click

on the  radio  subscriber.  To  customize  the  appearance  and  behavior  of  the  Call  Window,  to  the  Call  Window

settings.
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Making a call

The PTT button is located in several places: in the Radio Fleet panel and in the Call Window. Depending on the

call status, the PTT button can be displayed in the following colors:

1. Light yellow  – outgoing call attempt; or, a call in the queue (in conventional systems);

2. Yellow  – outgoing call from SmartPTT Dispatcher to the to radio subscriber;

3. Green  – incoming call to SmartPTT Dispatcher or radio monitoring;

4. Blue  – none of the parties  transmit  or receive voice (hang time).  The  subscriber  or  the  dispatcher

can continue the call  by  pressing the PTT button within hang time.  After the hang time expires,  pressing

the PTT button will initiate a new call.

To  call  a  radio  subscriber,  select  the  subscriber  from  the  Online  Subscribers list  and  click  PTT  next  to  the

subscriber name or press the specified keyboard hot  key.  The PTT button changes its  color to light  yellow,  and

then to yellow. The caller subscriber will  hear your voice.  To give the subscriber an opportunity  to respond,  press

the PTT button once more.  At  that,  the color of the PTT button changes to blue.  When the subscriber starts  to

respond, the color of the PTT button changes to green.

Sending messages

To send a message to a subscriber, click  in the Call window of the radio subscriber or click  Send Message

in the Action List.
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Save Template – saves the typed message as a template.

Delete Template – deletes a template selected in the list of templates.

Send – sends the typed message to the subscriber

Cancel – the Text Message window closes and the message is not sent.

You can also send a message using the Type text and press Enter field.

How to change subscriber name using radio

A subscriber can easily  change  his  or  her  name  by  using  the  radio.  At  that,  the  new name  will  appear  in  the

Subscriber panel.

To do it, you need to send the text message profile%name:<new name> to the Slot ID set in your system.

Before sending:
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After sending the message:

The Properties Window

To  open  the  Properties  window  of  the  radioserver,  control  station,  talkgroup,  radio  subscriber,  dispatcher  or

telephone subscriber, right-click on the corresponding item.

The Properties window of the radioserver

Server  Version  –  the  version  of  the  radioserver.  If  the  version  of  SmartPTT  Radioserver  does  not  match  the

version of SmartPTT Dispatcher, the version number is displayed in red.

Comments – text field for additional information.

The Properties window of the hardware control station
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The window displays information on the control station, for example, model number,  serial number,  control station

type, frequency range, firmware version,  control station identifier.  Also,  it  allows you to switch the control station

channels (select from the list or using the arrow keys) and to adjust volume level of the selected channel.

The Properties window of the virtual control station

The window displays information on the virtual control station, for example, serial number, firmware version,  control

station identifier, type of network configuration. Also, it allows you to adjust volume level of the selected channel.
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The Properties window of the talkgroup

Comments – text field for additional information.

Click the Telemetry button  to select telemetry command for the talkgroup.

The Properties window of the subscriber

The General tab:

IP  – IP address of the radio subscriber to identify  the subscriber radio.  If the IP  field is  absent,  specify  CAI  and

Radio ID.

MDC ID – the identifier used to identify  Motorola Data Communication (MDC) messages.  You cannot  type more

than 4 hexadecimal numbers into this field. It is used only in the analog mode.

5 Tone  ID – the  radio  subscriber  identifier,  If  the  radio  works  on  the  analog  channel  and  supports  the  5  Tone

signaling (SelectV).  It  must  match the 5 Tone  Radio ID in the General  Settings tab of  the  radio  MOTOTRBO
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CPS settings. To be set in the range from 0 to 9 or from A to G or R.

Note: Several IDs can be used as the radio identifier. If the radio is  used on the analog channel only,  just  5 Tone

ID (and MDC ID if necessary) must be filled, and the CAI and Radio ID or IP fields must be empty.

Name – the subscriber’s name.

Status – the subscriber’s status.

Select – click  to upload the radio subscriber's  image if there is  any.  To  delete  the  selected  image  of  the  user,

click the cross symbol on the left to Select.

 – click the button to select the icon of the subscriber.

 – click the Telemetry button to specify telemetry actions to the radio subscriber.

Lone Worker – select the check box to assign the Lone  Worker Profile  to a radio subscriber.  Select  from the

list the profile of the lone worker.

Note: You can add lone worker profiles in SmartPTT Dispatcher in the Settings menu under Lone Worker Rules.

The Location tab:

GPS – select the check box to see the subscriber on the map. The subscriber radio must support GPS.

Note: To set up GPS for SmartPTT Radioserver, specify the required settings described in the GPS  section of the

SmartPTT Radioserver Configurator help file.

The Update location area allows you to specify the location update criteria:

with time  interval,  s – the time interval in seconds after which the GPS coordinate request  will  be  sent  to  the

radio subscriber.

Note: You can set the main time interval for receiving GPS coordinates  in the subscriber Properties window. The

minimum  interval  for  receiving  GPS  coordinates  is  set  on  the  radioserver.  Therefore,  if  the  interval  from  the

Properties window is less than that set on the radioserver, GPS coordinates will  be received at  an interval set  on

the radioserver.

with distance  interval  – the distance interval in meters  or feet  after which the  GPS  coordinate  request  will  be

sent to the radio subscriber.

on GPIO pin status change – the GPS coordinate request will be sent to the radio subscriber when the status  of

telemetry contacts changed.
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on  emergency  –  the  GPS  coordinate  request  will  be  sent  to  the  radio  subscriber  when  the  radio  subscriber

sends an emergency alarm.

Indoor Tracking – select  the check box to  see  the  subscriber  on  the  building  plan  by  the  dispatcher  request

(the Find on Indoor Plan action) or after the predefined time period (the Update Interval, s field in the Location

tab of the radio subscriber Call Window). The subscriber radio must support Indoor Tracking.

Note: To set  up Indoor Tracking for SmartPTT Radioserver,  specify  the required settings described in the Indoor

Tracking section of the SmartPTT Radioserver Configurator help file.

Update  Interval,  s –  the  time  interval  in  seconds  for  location  data  update  from  special  beacons,  which  are

installed in buildings.

The Custom tab contains subscriber's custom properties, which were added by the system administrator.  If there

are no any added custom properties, the Custom tab is absent.

Note: Properties window of the mobile device has the same interface,  but  only  Lone  Worker and GPS  functions

are partially available there.

2.4.5  Subscribers

The Subscribers panel provides convenient  interface to perform voice calls  and  subscriber  property  modification

by generating a list of large control buttons for radio subscribers.

To open the Subscribers panel,  expand the Tools menu in the Main Menu bar and click  Subscribers.  At  that,

the Subscribers panel opens.
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All subscribers – all registered radio subscribers (online and offline).

Online – online radio subscribers only.

Manual Selection – radio subscribers  selected manually  by  the dispatcher.  To do it,  drag the  radio  subscriber

into the panel window.

In brackets you can see the number of subscribers in each category. 

To find a particular subscriber, use the search field. You can search by name or radio ID.

To  make  a  call,  click  on  the  subscriber  button,  or  select  the  subscriber  and  press  the  PTT  button.  The  PTT

settings defined in Control Devices are applied to this panel.

To open the subscriber's Call Window, right-click the subscriber button. 

To perform actions with the subscriber, click the button .

You can distinguish between radio subscribers’ states  on the panel.  Different  states  differ by  color of the control

button and the frame around it. The colors are the same as in Custom Consoles.

 – the icon on the subscriber button shows that the dispatcher did not answer to the subscriber call. The

figure next to it shows the number of missed calls.

2.4.6  Job Tickets

The Job Tickets panel allows creating special assignments  for radio subscribers  or talkgroups and tracking their

performance.
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Note: This functionality is supported only by MOTOTRBO SL Series  portable radios.  When a job ticket  is  sent  to

the radio, which does not support this functionality, it comes as a message,  for example,  <JTS> Job Ticket ? 1

Create weekly report.

To create a job ticket,  expand the Tools menu in the Main Menu bar of the  SmartPTT Dispatcher  window and

click Job Tickets.

The Job Tickets panel can be divided into three parts:

Filters

Job Ticket List

Status Change Log

The filters arrange the list of job tickets to the operator's taste. 

You can hide job tickets  from the job list  after the particular status  is  achieved.  To do  that,  deselect  the  Show

complete job tickets check box.
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To create a job ticket, click Add.

Name – job ticket name. It is a required field.

Description – description of the job ticket. Also required field.

Validity period – defines the time period during which a job ticket  can be assigned to offline radio subscribers.

After this  validity  period expires,  the job ticket  is  never  sent.  If  a  job  ticket  is  not  completed  before  the  validity

period has expired, the job ticket gets the status "Outdated".

Assigned – job tickets can be assigned to an individual radio subscriber or to a talkgroup. To do this,  simply  drag

a subscriber or a talkgroup in this  field.  To remove the assigned subscribers,  select  the subscribers  from the list

and press DELETE.

After  creation,  the  job  ticket  will  be  displayed  in  the  job  list  with  the  default  status  value.  When  the  radio

subscriber changes the job ticket status, the status in the job list  will  be changed accordingly.  If the job ticket  is

assigned to a talkgroup,  the job ticket  table will  contain the name of the radio subscriber,  who  changed  the  job

ticket  status.  Job  tickets  can  be  assigned  to  offline  subscribers  too.  As  soon  as  offline  subscribers  become

online, they get the job tickets (if the validity period has not expired). 

To see the history  of changes for job ticket  statuses,  click  on the job ticket  status.  At  that,  the Status Change

Log table will display the information about status updates.

To cancel the job ticket and delete it from the job list, click Delete. At that, the radio subscriber,  to whom the job

ticket  was assigned,  will  receive a text  message that  the job ticket  was canceled (only  if  Send  notification  to
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subscriber when uncompleted job ticket was deleted by dispatcher is checked in Job Ticket Statuses). 

If  the  job  ticket  has  not  been  delivered  (see  Status Delivery)  for  some  reason,  or  if  you  want  to  resend  the

existing job ticket to a radio subscriber or a talkgroup, click  Resend.  In this  case,  the edit  window will  open,  and

after clicking OK, a job ticket with a unique number will be sent. Use of unique numbers  is  important  for job ticket

resending, because radios ignore job tickets with same titles. Therefore,  before resending a job ticket,  make sure

automatic numbering is enabled (Settings > Job Ticket Statuses).

To get  information about  job  ticket  statuses  for  a  period,  when  the  dispatch  console  was  turned  off,  click  Get

Update Status.
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2.4.7  Sound Panel

The Sound Panel allows setting individual sound level for each control station, turn on/off sound for the subscriber

or talkgroup, select only one control station with the sound turned on.

To open the Sound Panel,  expand the Tools menu in the Main Menu bar of the SmartPTT Dispatcher window

and click Sound Panel.

The Sound Panel window.

Unmute All – turns on the sound for all the connected control stations.

Mute All – turns off the sound for all connected control stations.  Mute control stations are marked with a special

symbol.

Cancel – calls off the last action.

To manipulate the sound level, click the – / + buttons or move the thumb.

To turn on/off the sound on a particular control station, click .

To turn on the sound for one control station and at  the same time to turn off the sound for other control stations,
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click . 

To turn on/off the sound for talkgroups, click . At that, a window will  open with the list  of available talkgroups

on the slot. Mute talkgroups are marked with the special symbol.

Sound settings for a control station can also be done in the control station Properties window. 
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2.4.8  Monitoring

2.4.8.1  Monitoring

The Monitoring panel is a complex tool which gives a comprehensive outlook on the whole radio system. 

It includes four tabs:

1. Monitoring

2. Topology

3. Diagnostics

4. Event Log

Monitoring  –  graphical  representation  of  data  and  voice  received  from  MOTOTRBO  repeaters,  which  allows

observing the ongoing system operation. Each logical channel has a section for displaying transmitted packets  in

the form of colored vertical bars. The height of the bar corresponds to the level of the received signal;  and the color

corresponds  to  the  event  type  according  to  the  legend.  In  order  to  see  the  radioserver  and  its  network  in  the

Monitoring tab,  make sure that  the Monitoring  service  is  enabled  for  this  radioserver  in  SmartPTT Radioserver

Configurator.

To use monitoring in SmartPTT Dispatcher, you need to enable it  in SmartPTT Radioserver Configurator,  create a

new monitoring database or connect to the existing one.
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Graphical representation of data packets is displayed only for the selected network. 

Note: The list on the left  shows only  active networks  (IP Site Connect,  Capacity  Plus,  Linked Capacity  Plus  and

Connect Plus) of SmartPTT Radioserver. If a network becomes inactive, it disappears from the list. 

Show Details – when selected, events from different slots appear in separate blocks.

Show Summary – when selected, events from different slots appear in one block. 

When checking both parameters, all the three blocks are displayed.

Data displayed in blocks:

Name Description

System
System  events  from  MOTOTRBO  equipment  (data  confirmation,  private  call

confirmation, etc.)

ARS
Registration  information,  that  is  information  about  radio  availability  in

the network

Location Coordinates of the radio with GPS support (GPS service)



81Tools

Dispatch Console User GuideSmartPTT PLUS 8.7

Name Description

Indoor Location Radio's locations inside a building (i.e., Indoor Positioning)

Тext Message Receiving and sending text messages (TMS service)

Telemetry Transmitting and processing telemetry signals

Call Alert Call alert sent to the radio subscriber

All Call Calling to all radio subscribers registered on one logical channel

Group Call Calling to a particular talkgroup

Private Call Private call from or to the radio subscriber

Remote Monitoring
Radio remote monitoring.  This  refers  to  the  request  only.  The  actual  remote

monitoring is highlighted as the private call.

Emergency Alarm Emergency signal from the radio

Emergency Call Emergency call from the radio

Phone to Talkgroup Group telephone call between the telephone subscriber and the talkgroup

Phone to Radio Telephone call between a telephone subscriber and one radio 

Levels displayed on the right to the blocks (High, Medium, Low) correspond to the RSSI level ranges:  -80 or more

(High), -80 to -100 (Medium) and -100 or lower (Low).

The event  log at  the bottom of the screen gives  more  detailed  information,  namely  the  type  of  transmitted  data

(ARS, GPS, Message, Emergency Call, etc.), date and time of the event,  its  duration,  initiator's  and addressee's

IDs, repeater ID and RSSI level, site ID (applied to LCP systems only), network name.
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2.4.8.2  Topology

Topology  –  schematic  representation  of  active  networks.  A  network  topology  is  set  in  SmartPTT  Radioserver

Configurator and displayed in SmartPTT Dispatcher.

Note: In order to see the radioserver and its network in the Topology tab,  make sure that  the Monitoring service

is enabled for this radioserver in SmartPTT Radioserver Configurator.

Graphical objects used in topology:

Graphical Object Description

Major alarm on device or no connection

Device is connected or no alarms registered on device.

Minor  alarm  is  registered  on  device  or  there  are  more  than  5

packets lost or corrupted.

Repeater is turned off.

Repeater is not connected.
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Graphical Object Description

SmartPTT Radioserver

Network in folded state

Virtual repeater (i.e., SmartPTT Radioserver), or MNIS

Slave hardware repeater

Master hardware repeater

Master virtual repeater

Repeater is not connected, but it is included in the peer map.

Repeater is connected, but it is not in the peer map.

Location in folded and unfolded state

Uninterruptible power supply (Eaton)

Cisco router

Unknown device (any other device)
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Note:  Network  configuration  is  set  in  SmartPTT Radioserver  Configurator.  Repeaters,  which  are  added  but  not

active,  are  marked  red.  If  network  configuration  is  not  set  in  SmartPTT  Radioserver  Configurator,  the  network

topology will be generated automatically based on the information received from the available network  repeaters.  If

IP-connection with the repeater is lost, it disappears from the topology screen.

Repeater loading on both logical channels is displayed in percents above each repeater.

 

Loading percentage grows steadily,  not  sharply,  until  the maximum value.  When both logical channels  are used,

the maximum value is 100%, when only one logical channel is used— 50%.

A busy channel is represented by a yellow LED on the repeater.

 

Repeater ID is displayed under repeater.

Application peer ID is specified in SmartPTT Radioserver Configurator (Peer ID).

Note: All the repeaters used in one network should have unique ID's.

1. Radioserver

To fold and unfold the network, right-click on the radioserver and select Fold or Unfold respectively.
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To view radioserver parameters and the ongoing performance information,  right-click  on the radioserver image and

select Information.

Operating System – provides information on the OS used on the server.

Processor Load – displays current CPU load and other information about PC memory.

Hard Disks – provides information on the the available hard disks of the PC and their characteristics.

Network Interfaces – displays the network interface and the sub network mask of the PC.

Sensors  –  displays  platform  status  (for  example,  system  temperatures,  voltages,  fans,  power  supplies  and
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chassis intrusion).

To operate remotely, right-click on the radioserver image and select Control. At that, the following window opens.

Power Status – shows the current status of the radioserver. There can be three statuses:

Switched On

Switched Off

N/A Unknown (in this case check that IPMI settings are correct)

OS Power Management – allows users to turn off the radioserver at the OS level.

Hard Power Management – allows users to turn on/off or to hard reset the radioserver computer at  the hardware

level.

Note: If the radioserver computer is blocked, you can turn off the radioserver computer only at the hardware level.

If you have more than one radioserver, you can arrange them in the Topology tab either vertically  or horizontally.

The layout  can be selected in the Layout dropdown at  the bottom of the Topology tab.  The  selected  layout  is

applied not only to radioserver elements, but to all elements, which can be folded and unfolded. 
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2. Repeater

To view repeater parameters and statistics, right-click on the repeater element and select Information.

Repeater parameters:

Name Description

Repeater Repeater ID

IP-address Repeater IP-address

Model Repeater model number

Firmware Version Version of firmware used in repeater
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Name Description

Codeplug Version Repeater parameter block version

Serial Number Repeater serial number

Voice Calls Ability to transmit voice (Yes, No)

Data Calls Ability to transmit data (Yes, No)

Statistics:

Name Description

Channel Loading (%) Channel loading on repeater for the last 10 seconds

Transmissions Started Number of times the PTT button was pressed

Registration (ARS) Number of registration packets transmitted for the last minute

GPS Number of GPS coordinates transmitted for the last minute

Messages Number of text messages transmitted for the last minute

Telemetry Number of telemetry packets transmitted for the last minute

Broken Packets (RX) Number of packets (Rx) with errors, received for the last minute 

Maximum  Number  of  Broken

Contiguous Packtes (RX) 

Maximum number of broken packets (Rx) in a row

Number of Transmit  Collision

Packets (TX)

Number  of  not  transmitted  packets  due  to  collisions  on  the

channel

Uptime The time during which the repeater is available in the network



89Tools

Dispatch Console User GuideSmartPTT PLUS 8.7

To operate remotely, right-click on the repeater element and select Control. At that, the following window opens.

Note: You cannot operate virtual repeaters remotely, therefore, the Repeater Control  window is  available only  for

hardware repeaters connected to the radioserver.

Current  Channel  –  channel  used  by  the  repeater.  Channels  are  set  in  repeater  settings  with  the  help  of

MOTOTRBO Customer Programming Software (MOTOTRBO CPS). 

Power, TX – transmitter power of repeater. There are high and low modes. Bands for both modes are specified in

MOTOTRBO CPS.

State  – allows switching the repeater to “active”  or  “not  active”  mode.  When  in  the  “not  active”  mode,  repeater

does not transmit any signals. To switch the repeater to the “active” mode, select On in the State field. 

Restart – allows restarting repeater remotely.

Apply Settings – applies settings specified in the Repeater Control window. 

Cancel – closes the Repeater Control window without making changes in the repeater settings.

3. Uninterruptible Power Supply (UPS)

Currently, you can select between Eaton UPS and any other UPS if you select Unknown in the Type field. 

To view parameters and status information of Eaton UPS, right-click on the UPS element and select Information.

Identification:

Name Description

Model Eaton UPS model

Serial Number Device serial number 

Firmware Firmware version
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Name Description

IP-address IP-address

Network Mask Network mask

State:

Name Description

Alarm Details Informs about issues in UPS operation

Input Power Source Input Power Source

Output Power Source Output Power Source

Last Battery Replacement Date and time when battery was replaced last time
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Parameters:

Name Description

Input Voltage (V) Input voltage level (V)

Input Frequency (Hz) Input frequency level (Hz)

Output Voltage (V) Output voltage level (V)

Output Frequency (Hz) Output frequency level (Hz)

Output Current (A) Output current level (A)

Output Power (W) Output power level (W)

Load (%) Eaton UPS loading in percent

Battery Charge (%) Battery charge left in percent

Charge Left (hh:mm) Battery charge left in hours and minutes

4. Router

Currently, you can select between Cisco router and any other router if you select Unknown in the Type field.

To view parameters and other information of Cisco router, right-click on the element and select Information.

Identification:

Name Description

Model Cisco model

Serial Number Cisco router serial number 

Alarms – gives information about issues in the router operation.

5. Unknown Device

Unknown device is any kind of device other than Cisco 2900 and Eaton 9130.

To view information on the device, right-click on the element and select Information.



92Tools

Dispatch Console User GuideSmartPTT PLUS 8.7

Parameters:

Name Description

System Name Name of the device

System Description Description of the device

Alarm Details Informs about issues in the device operation

6. Location

To change the way Location is displayed, right-click on the Location element, or click on the Plus/Minus icon.

There are two display modes: 

Folded

Unfolded

Folded – location is displayed as an image inside a box.

Unfolded – displays which devices, repeaters and routers are used in this location.
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To change the default image of Location, right-click on the object. At that, a drop-down will appear where you can

either upload your own image or set the default image.

2.4.8.3  Diagnostics

Diagnostics – provides information about the current state of the connected MOTOTRBO repeaters and alarms.
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To select columns to be displayed, right-click  on the menu bar with the column names.  At  that,  the following list

opens.

Note: By default, all columns are enabled.

On the right  side of the panel you can find all  the technical information about  the repeater selected in the  table,

including the repeater's statistics, its properties, and alarms (if there are any).  

2.4.8.4  Event Log

The event log of monitoring is one of the best  ways to learn about  hardware alarms,  for example,  it  informs about

repeater connection or about Cisco and Eaton state. 

Note: Events with severity "Critical", "Major" and "Minor" are highlighted red, pink and yellow respectively.

Besides  reviewing  current  events,  Event  Log  provides  the  ability  to  view  saved  events  for  the  particular  time
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period.

To review events for a time period,  select  Show  Logged Events,  define the period limits  by  using the calendars

for start and end dates, select the radioserver from the drop-down and click Apply.

2.4.9  Lone Workers

The Lone  Workers panel displays  the list  of subscribers  who are in  the  Lone  Worker  mode  and  their  current

status. This was designed for a better supervision over lone workers.

To open the Lone  Workers panel,  expand the Tools menu in the Main Menu bar of  the  SmartPTT Dispatcher

window and click Lone Workers. At that, the following window opens.

The Lone Workers panel shows radio subscribers working in the Lone Worker mode marked with specific  color.

The color shows if the subscriber meets the requirements set for the lone worker profile the subscriber belongs to:

Light gray – the lone worker did not violate the rule.

Yellow – rule violation: the event, described by the rule, has occurred. Alert Timer starts. 

Red – the lone worker did not react in a specified way after Alert Timer expired.

Note: For more information how to set rules for lone workers, please see Lone Worker Rules.

To turn off the Lone Worker mode, click the cross button.

2.4.10  Latest Incoming Calls

The Latest Incoming Calls panel displays the list  of subscribers  who initiated calls.  The panel is  used for quick

access to the call windows of the subscribers. 
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To open the panel, expand the Tools menu in the Main Menu, and click Latest Incoming Calls.

Click on the subscriber record to open the Call Window. 

To configure the Latest Incoming Calls panel settings, expand the Settings menu in the Main Menu,  and click

Events and Notifications.
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Remember the latest incoming calls  – allows you to save records of calls to which you did not answer.

To apply the changes, click Finish.

2.4.11  Notifications

The  Notification  window  informs  the  dispatcher  that  the  set  of  rules  were  not  fulfilled  and  the  alarms  were

activated. 

The following rules are displayed in the Notifications window:

Rules and Alerts

GPS Rules
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Lone Worker Rules

When the specified event happens and one of the rules triggers, the notification window opens up automatically  to

display the alarm notification.

The usual notification is composed of the following parts:

Caption

Subscriber name and time

Text of the alarm

2.4.12  System Messages

The  System  Messages  window  displays  notifications  which  inform  about  interaction  between  SmartPTT

Dispatcher and SmartPTT Radioserver. 

There are three notification types shown in the System Messages window:

Error messages

Warnings

Information messages

To  set  up  System  Messages,  expand  the  Settings  menu  in  the  Main  Menu  bar  and  click  Events  and

Notifications. In the opened window select the Notification Panels tab.
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In the System Messages section select the check boxes next to the notification types of which the operator is  to

be informed.

Note: If none of the check boxes is  selected,  notifications will  be registered in the background,  i.e.,  the System

Messages window won’t open automatically. In this case, if an error is registered, an error message will appear.

To open the System Messages panel manually, expand the Tools menu in the Main Menu bar and click System

Messages.
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All the three message types (Error Messages, Warnings, Information Messages) have the following format: 

1. Source of the problem:

a) "Client" (SmartPTT Dispatcher)

b) "Server" (SmartPTT Radioserver)

c) "Client-Server Connection" (connection between SmartPTT Dispatcher and SmartPTT Radioserver)

d) "Database" 

2. Problem description.

Each message can be differentiated by the following characteristic traits:

Icons:

: used for error messages;

: used for warnings;

: used for information messages.

Colors of the messages:

Red is used for error messages.

Gray is used for warnings and information messages.
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2.4.13  Server Tasks

The Server Tasks window shows the list of commands from the dispatch application the radioserver is  processing

at a given moment of time.

For now, only a few commands are displayed in the Server Tasks window, for example,  the command to create

the radioserver event log.

2.4.14  Map Tools

2.4.14.1  Points of Interest

The Points of Interest panel displays  all  the exiting points  of interest.  You can also  create,  modify  or  delete  a

point of interest from the panel.

To view points of interest (POI) to be displayed on the map, expand the Tools menu in the Main Menu bar of the

SmartPTT Dispatcher window, click Map Tools and then Points of Interest.

At that, the Points of Interest panel opens.

 In the panel window you can do the following:

Create a new POI

View the list of created POIs

Hide or show POIs on the map
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To create a new POI:

1. Open a map.

2. Click Create.

3. In the opened window type the name of the POI and upload its picture. Click OK.

4. Place the new POI on the map by clicking the left mouse button.

5. To save the position of the POI click Save in the panel window. To call off the changes, click Cancel.

You can also create the POI from the Map menu. For more information see Maps.

To hide or show the POI on the map, select the check box next to the POI title.

2.4.14.2  Geofences

The Geofences panel is used to create, modify and display geofence on the map.  Geofences help dispatchers  to

keep  an  eye  on  subscribers.  A  dispatcher  can  define  the  area  of  the  geofence  on  his  or  her  own  and  attach

special rules to it.

To  open  the  Geofences panel,  expand  the  Tools menu  in  the  Main  Menu  bar  of  the  SmartPTT  Dispatcher

window, click Map Tools and then Geofences. At that, the following window opens up.

To create a new geofence:

1. Open a map.

Note: Geofence creation with Map Point is not supported.
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2. Click Create in the Geofences panel window.

3. In the opened dialog box type the name of the geofence and select the color. Click Create.

4. Draw the geofence on the map with the help of mouse and the keyboard. The geofence must  have at  least
3 points. To undo the last added point press the ESC key.

Note: You can also stop drawing the geofence by double-clicking on the last point of the zone.

5. Click Save in the Geofences panel window.

6. The record about the new geofence will appear in the Geofences panel.

7. You can activate the geofence in this panel by  selecting the check box next  to the name of the geofence
and edit it by clicking Edit. You can also change the color of the geofence. 

To call off creation of the new geofence, click Cancel. To modify the existing geofence, click Edit.

You can also create geofences from the Map menu. For more information see Maps.

To assign a rule to the geofence, go to GPS Rules.

2.4.14.3  Routes

Route  is  a  tool  of  SmartPTT  that  significantly  extends  functionality  of  the  dispatch  system,  especially  for

monitoring and controlling networks  of highly  mobile subscribers  moving along the predefined route (for example,

employees of transportation companies).  Its  meaning radically  differs  from the pre-existing concept  of  a  "Route"

as the trajectory of subscriber’s movement that, from now on, is called "Track".

The route, starting with version 7.1.0 is a polyline connecting key points  of the network  coverage area.  Subscriber

location  near  the  key  points  is  identified  by  the  specified  radius  of  the  route  and  can  be  summarized  in  the

Subscriber Locations report.
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To open the Routes panel,  expand the Tools menu in the Main Menu bar of the SmartPTT Dispatcher window,

click Map Tools and then Routes. At that, the Routes panel opens.

To create a new route:

1. Open the map window and click Create. At that, the New Route window opens.

2. In the field Name type the name of the new route.

3. Set the color of the new route.

4. In the Radius field enter allowed deviation from the route.

5. Click Create.

6. Go to the map window and draw the route. 

Route points  are created by  clicking with the left  mouse button  on  the  map  area.  To  create  the  first  route

point,  point  to the place where the route starts  and left-click  on it.  To create next  route points,  point  to  the

appropriate place on the map and left-click  on it.  Route points  connect  sequentially  drawing a new route on

the map. To undo the last added point, press Esc. 
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You can stop drawing the route by double-clicking the last point of the route. 

7. To save the route, click  Save  in the Routes panel window. To call  off the route,  click  Cancel.  To modify

the existing route, click the Edit button .

2.4.14.4  Subscriber Location Panel

Subscriber Location panel shows the subscribers inside the selected area on the map.

To  select  area  on  the  map,  press  CTRL  and  click  with  the  left  mouse  button  and  draw  the  area  covering

subscribers.

Note:  The Subscriber Location panel will  be opened automatically  if  it  is  hidden  at  the  moment  of  subscriber

selection.

Opened Subscriber Locations panel.

Click  to find the subscriber on the map.

To manually open the Subscriber Location panel use the Tools menu in the Main Menu bar. 

2.5  Settings
The Settings menu allows you to configure system parameters, create special rules,  which will  help you manage

workers, connect external third-party devices and so on:

Database allows you to manage the system database, i.e., create new database or connect to the existing

database.

Licenses allows you to install licenses.

General Settings allows  you  to  tune  the  dispatch  console,  e.g.,  define  the  PTT button  behavior,  enable

automatic system updates, select language, etc.

Control Devices allows you to select and configure control devices to be used in SmartPTT Dispatcher,  like

the mouse, touchscreen and other devices.
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Radioservers  allows you to manage  available  radioservers,  e.g.,  add  new radioservers  to  be  seen  in  the

dispatcher console, assign profiles to the available radioservers. 

Statuses  allows  you  to  add  statuses  for  radio  subscribers  displayed  in  the  Subscribers  Management

panel.

Event Log allows you to manage the event log and the system messages.

Call Windows allows you to configure Call Window parameters, e.g., specify the type of event  that  triggers

the window opening.

Sound Settings allows you to configure sound settings and set up multichannel sound.

Records allows you to enable call recording and set up recording parameters.

Positioning Systems allows you to configure GPS and Indoor settings.

Telemetry allows you to configure telemetry commands to be available.

Categories allows you to create categories.

Dispatchers allows you to add other dispatchers and configure parameters of your own dispatcher console.

Telephone Interconnect allows you to configure telephone settings and Telephone Subscribers  allows you

to create a list of telephone subscribers.

Job Ticket Statuses allows you to add statuses for job tickets.

Third-Party Equipment allows you to configure Tipro settings.

Hot Keys allows you to customize keyboard shortcuts for making calls to subscribers.

Database Auto Backup allows you to set the SmartPTT Dispatcher database auto backup.

Rules and Alerts allows you to set up rules based on general events.

Positioning Rules allows you to set up rules based on GPS and Indoor data.

Lone Worker Rules allows you to create and set up rules for lone workers.

Subscriber  Custom  Properties  allows  you  to  add  additional  properties  to  be  displayed  in  subscriber

Properties window.

Custom Consoles allows you to create custom consoles with necessary elements.
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2.5.1  Database

To  connect  to  the  database,  expand  the  Settings menu  in  the  Main  Menu  bar  of  the  SmartPTT  Dispatcher

window and click Database. At that, a configuration window for database creation opens.

To  create  a  new database,  fill  in  the  Database  server  name  field,  and  click  Create  New  Database.  In  the

window that opened enter the name of the new database and click Save.

Note:  For the database server installed together with the SmartPTT dispatcher application enter the  name  using

the format: Name of PC\SQLExpress (for example, MYCOMP\SQLExpress).
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Authorization Mode – allows you to select authorization mode with the database.

SQL Server Authorization – you must  have the  login  and  password  of  the  account  which  has  access  to  the

SQL server.

Windows NT Authorization – the user who has logged into  the  Windows  system,  must  be  listed  in  the  SQL

server’s list of users to make connection.

Current database – allows you to connect to one of the created databases.

In  case  of  successful  authorization  the  message  "Connection  is  established  successfully!"  is  displayed.  If

authorization fails, the reason will appear at the bottom of the window.

Restore  from file  –  allows  you  to  restore  the  current  database  backup.  You  can  set  up  auto  backups  of  the

database under Settings > Database Auto Backup.

To apply the changes connected to the database, restart the dispatch console.

2.5.2  Licenses

To use the SmartPTT application you need to install  licenses.  There are licenses for basic  features  which  allow

you to run the application and licenses for additional features,  like telephone connection support,  bridging,  SNMP

service, etc.



109Settings

Dispatch Console User GuideSmartPTT PLUS 8.7

To install  licenses,  expand the Settings menu in the Main Menu  bar  of  the  SmartPTT Dispatcher  window and

click  Licenses.  The  configuration  window opens  from  where  you  can  load  license  files  which  define  functions

available in the system.

Click Install License – the browse window will open. Specify the license file’s location and click Open. 

The license is  installed,  and the system licensing window displays  information on the license type and scope of

functions.

After the license is installed, the Install  License  button will  change to the Restore  License  button.  Clicking the

Restore  License  button,  you  return  to  the  previous  license.  After  the  Licensing  window is  closed,  the  latest

displayed in the window license will be applied.
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Note: If the radioserver and the dispatcher console are installed on one and the same machine, you can install  the

licenses  either  in  SmartPTT  Radioserver  Configurator  or  in  SmartPTT  Dispatcher.  If  the  radioserver  and  the

dispatcher console are installed on different PCs, you need to install the licenses in both applications.

2.5.3  General Settings

In the General  Settings window you can  configure  the  global  settings  of  the  SmartPTT Dispatcher  application

(e.g., user interface language, automatic update, etc).

To set the general settings,  expand the Settings menu in the Main Menu bar and select  General  Settings.  At

that, the following window appears.
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Subscriber ID input method sets  the  input  and  display  methods  used  for  showing  subscriber  ID  in  the  radio

subscriber Properties window: IP address or CAI + subscriber ID.

IP Address – IP address is entered and displayed in the subscriber's Properties window:  .

CAI  +  Subscriber  ID  (CAI network  ID  and  a  unique  radio  ID)  are  entered  and  displayed  in  the  subscriber's

Properties window:  .

Launch  the  dispatch  console  on  Windows  start  –  enables  automatic  launch  of  SmartPTT  Dispatcher  on

Windows start with the selected account.

Call alert tone duration (s) – sets how long the call alert will sound in SmartPTT Dispatcher.

Outgoing call tone – this alert tone sounds after the PTT button is  pressed and the operator is  able to transmit

on the channel. This is to prompt the operator to begin speaking.

Ask for confirmation before  closing or changing the  operator – if selected,  you will  need to confirm  before

closing SmartPTT Dispatcher, or before changing the operator. 

Language  – allows you  to  change  user  interface  language.  After  selecting  a  new language,  restart  SmartPTT

Dispatcher to apply the change.

To enable automatic update, select the Automatic Update  check box.  If the check box is  selected,  the system

will be checking for updates on a regular basis.

In the File  path field specify  the path to the ClientSetup.exe  file,  which you download together with SmartPTT

Software Installation Package. If a new SmartPTT version is  available,  when you launch SmartPTT Dispatcher (or

when you choose Check for Updates from the Help menu), the notification window will appear.

Note: After downloading the new version of the system, it is not necessary to uninstall the previous version.

2.5.4  Control Devices

In  the  Control  Devices  window  you  can  select  and  configure  the  control  device  to  be  used  in  SmartPTT

Dispatcher. This can be a mouse, touchscreen, keyboard or other external input device.
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To define the control device,  expand the Settings menu in the Main Menu bar and select  Control  Devices.  At

that, the following window appears.

The window is divided into three group boxes, devoted to a mouse, a touchscreen, and to external devices. 

Under Mouse  and Touchsreen you can select  the action that  will  be performed at  clicking or tapping,  and  PTT

mode.  These  settings  will  be  applied  to  several  panels:  Radio  Fleet,  Subscribers,  Call  Windows,  Custom

Consoles, Emergencies. The Calls panel does not support these settings—single click is applied there.

The External Devices group box allows you to set up the following devices: 

keyboard;

external input USB device;
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external input device connected via COM port.

To  assign  PTT to  a  keyboard  button,  click  on  the  button   next  to  Keyboard  PTT,  and  press  a

keyboard button.  At  that,  the  pressed  button  will  appear.  To  define  the  PTT mode  (i.e.,  pressing  and  release),

select Hold, or Single press.

To set up the PTT button on any external input device connected via USB, select Other Input Device and choose

the required device from the list. Then, click on the blue button next  to Device  PTT Button and press any button

on the device.

External Device COM Port – COM port used to connect to the external PTT device.

There are two modes available for the PTT button on external devices: Hold and Single press.

To save changes, click Finish.

2.5.5  Radioservers

To connect the existing radioserver to the dispatcher console,  expand the Settings menu in the Main Menu bar

and click Radioservers. The configuration window for setting up and configuring radioservers opens up.
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By default, the list of radioservers is empty. Click Add to open the window for adding radioservers.

Name – radioserver name displayed in the list of radioservers.

Address,  Port – radioserver IP address and port  number to connect  with  the  dispatcher  (the  default  radioserver

port number is 8888). Make sure that  the Address and Port you enter match the Address and Port specified in

SmartPTT Radioserver Configurator.
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In this example we use port 8888.

Proxy:port – is a proxy server IP address and port number of the connection.

Fields  Login  and  Password  must  be  filled  if  authentication  is  enabled  on  the  radioserver  side.  To  enable

authentication  on  the  radioserver  side,  run  SmartPTT  Radioserver  Configurator,  click  Radioserver,  select

Windows  in  the  Authentication  field.  Currently,  you  can  select  only  Windows  authentication.  If  Windows

authentication is  selected,  you can't  connect  the dispatcher console and  the  radioserver  without  indicating  valid

credentials  in the Login and Password fields.  If the radioserver computer makes part  of a  domain,  indicate  the

domain login and password, if not – indicate local login and password.

Note:  If  No  is  selected  in  the  Authentication  field,  make  sure  that  the  fields  Login  and  Password  in  the

dispatcher console are empty. Otherwise, the dispatcher console and the radioserver can't connect.

Active – if selected, the radioserver is available for connections.  You should also remember that  you do not  have

to remove the radioserver from the list to disable it. It is enough to clear the check box.

Operator – list of all active operators created in SmartPTT Dispatcher.
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Profile  Name  –  enter  profile  name  defined  for  the  dispatcher  in  SmartPTT Radioserver  Configurator.  If  Profile

Name  is  not  specified,  the  dispatcher  has  access  to  all  radios,  talkgroups  and  services  provided  by  the

radioserver. If the profile name is incorrect, the radioserver will be marked red.

Note: Profile management is described in the SmartPTT Radioserver Configurator help file.

After all the fields are completed, click OK. At that, the new radioserver appears in the list of radioservers.

To edit the radioserver settings, select it in the list of radioservers and click  Edit.  To delete the radioserver,  select

it in the list of radioservers and click Delete. To find all the running radioservers in the network, click Search. 

IPMI Settings

Intelligent Platform Management Interface (IPMI) is a standardized computer system interface used for out-of-band

management of computer systems and monitoring of their operation.

SmartPTT system uses IPMI for managing and monitoring remote radioservers. With the help of IMPI you can not

only learn about the hardware characteristics of the radioserver machine, but also turn it on/off remotely.
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To set up IPMI open the Server Settings window of the selected radioserver and then open the IPMI tab.

Address, Port – IP address and port number of the radioserver PC that are used to establish IPMI connection.

Login and Password are obligatory  fields.  They  must  match  the  login  and  password  set  in  IPMI configuration

settings on the radioserver PC.

Authentication – authentication types. Use MD5 as default authentication type.

Privilege  – depending on the privilege used,  the user  has  different  permissions.  Use  Administrative  as  default.

For more information about the privileges, check the official IPMI documentation.

Ciphers – the list of ciphers to be used. Select  the default  cipher,  that  is  RAKP-HMAC-SHA1, HMAC-SHA1-96,

AES-CBC-128.

Active – select the check box to activate IPMI functionality for the radioserver.
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2.5.6  Operators

By default  an operator with the name Administrator and no  password  is  created  in  SmartPTT Dispatcher.  The

Administrator has full access to SmartPTT management functions. 

The Administrator can add new system operators  and customize their access to specific  functionality.  To add a

new operator,  expand the Settings menu in the Main Menu bar of  the  SmartPTT Dispatcher  window and  click

Operators.

At that, the Operators window will be displayed.
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To add a new operator, click Add. A new window for adding operators opens up.

Name – operator’s name.

Status – operator’s status ("Active" or "Archive"). Status  in the archive is  used for registered operators  which are

not used any longer, but cannot be removed from the system as the event log contains entries referring to them.

Rights – a list of permissions which can be selected or cleared for each operator individually.

Here are some of them:

Add/Delete  subscriber units – the permission allows the operator  to  add,  delete  subscribers  and  modify  their

properties.

Manage  unregistered  subscriber  units  –  select  this  property  to  allow  operator  to  modify  unregistered

subscribers in the subscriber tree.

Attach  radios  to  selected  channel  –  select  control  stations  which  will  be  used  to  display  all  registered

subscribers. This option is recommended to be set for Capacity Plus systems.

Set/Change Password – set new operator's password or change the old one.

To edit  an operator,  select  it  in the list  of operators  and click  Edit.  The edit  window is  displayed where you  can

change Name, Status and Password parameters.

To delete an operator from the operators list, select it and click Delete.
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Note: You cannot delete the Administrator from the system.

To switch operators,  click   in the Main Menu and after the dispatch console has restarted,  select  a new

operator.

2.5.7  Statuses

You can create statuses to assign to radio subscribers  (for example,  Available,  On Call,  In Place or Busy).  Each

radio subscriber can have a status showing their current state. The status is set either by the dispatcher or by  the

radio subscribers themselves.
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To set  up statuses,  expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher  window and

click Statuses. At that, the configuration window opens.
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To add a new status, click Add in the Active tab. A window for adding a new status opens.

Name – status name to be displayed in SmartPTT Dispatcher.

Color – status color to be displayed in SmartPTT Dispatcher.

System Message  – message which triggers  status  change,  that  is  if a radio subscriber sends this  message  to

the dispatcher, the subscriber receives the status.

Sound – audio file played back if the status is activated.

Click OK, and the new status is added to the list of statuses.

To edit the existing status, select it in the list of active (the Active tab) statuses and click Edit.
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To delete a status, select it in the list  of active statuses and click  Delete.  You can delete a status  only  if it  was

never assigned to a subscriber. If the status is currently assigned to a subscriber or used to be assigned,  it  can't

be deleted. But, it can be moved to an archive. Characteristics of the archive statuses are:

They can't be assigned to radio subscribers.

They can't  be used in the alert  rule definitions.  However,  the archive status  remains valid as  an  alert  rule

criteria for a particular rule, if it was selected as such before being moved to the archive.

They are displayed in the event log entries.

They can be restored from the archive.

To see the list of archive statuses, open the Archive tab of the Statuses window.

To move the status  to the archive,  select  the status  from the active status  list,  click  Delete  and click  OK in the

opened dialog box to confirm the action.
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In order to restore the status from the archive, select the status from the archive list,  click  Restore  and then click

OK in the opened dialog box to confirm the action.

2.5.8  Events and Notifications

The Events and Notifications window provides the following settings:

Event log settings

Settings for the Emergencies panel

System message settings

To manage the event log, expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher window

and click Events and Notifications:
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Save  Events to  Log  –  when  the  check  box  is  selected,  events  data  is  saved  in  the  SmartPTT  Dispatcher

database.

Maximum number of records to be shown – sets the number of records to be displayed in the log.

Event Log Parameters – an area to configure cleaning settings for the event log.

Show time with milliseconds – sets time format to display milliseconds.

To save changes, click on Finish.

To set parameters for the Emergencies panel, click on the Notification Panels tab.
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Notify dispatcher about emergency – if enabled,  when receiving an emergency signal from a radio subscriber,

the system will  open the Emergencies panel,  play  the sound file,  if specified,  and will  open the map to  display

the radio sending the emergency signal. The radio location on the map is based on the latest GPS data.

Category for emergency – select a category, which will be responsible for resolving the emergency issue.  If the

category is selected, it will also appear on the map.

If enabled, the Emergencies panel opens automatically, when the system receives the emergency signal: 
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From the Emergencies panel the dispatcher can do the following:

Make a group call. The talkgroup is set in the radio parameters in MOTOTRBO CPS.

Turn off the sound alert by clicking .

Mark the issue as resolved by clicking . At that, the Emergencies panel gets closed.

To set parameters for the system messages, see System Messages.
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2.5.9  Call Windows

To  configure  the  parameters  of  the  Call  Window,  expand  the  Settings  menu  in  the  Main  Menu  bar  of  the

SmartPTT Dispatcher window and click  Call  Window  Settings.  At  that,  the  configuration  window opens  where

you can configure the appearance and functions of the Call Window.

Call  Window  Closing Timeout (sec) – sets  the time period in seconds at  the end of which the Call  Window

closes automatically.

Note: If you enter 0 in the field, the Call Window won't close automatically.

Open  Call  Window  for  Event  Types  –  specifies  types  of  events  triggering  the  Call  Window  opening

(Registration,  Call,  Message,  Telemetry,  Alarm,  Status,  Block  Radio,  Job  ticket,  Lone  Worker,  Radio

Check).



129Settings

Dispatch Console User GuideSmartPTT PLUS 8.7

Maximum Number of Opened Call  Windows –  allows  you  to  set  up  the  maximum  number  of  call  windows

opened automatically.

Show Photo in Call Window – select to display the subscriber's photo in the Call Window.

Show  Pinned  Call  Windows on  Console  Launch  –  if  selected,  the  position  of  the  Call  Windows,  pinned

before the SmartPTT Dispatcher application closing, will be restored during next launch.

Make  Call  Window  Active  upon Opening –  select  the  check  box  to  focus  on  the  Call  Window  when  it  is

opened or have a new activity.

Save Call History – allows you to keep call history when SmartPTT Dispatcher is closed.

Reset Saved Call Window Positioning – click the button to reset the current position of the call windows.

2.5.10  Sound

Warning! For proper operation,  make  sure  that you have  a  working  microphone.  If  not,  you  won't  be

able to make or answer calls.

To  set  audio  device  settings  and  VoIP  parameters,  expand  the  Settings menu  in  the  Main  Menu  bar  of  the

SmartPTT Dispatcher window and click Sound Settings. At that, the configuration window opens up.

The Sound Settings window includes:

1. General Settings tab

2. Audio Output Devices tab

3. Other Settings tab
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The General Settings tab:

Audio Input – audio device to which the microphone is  connected.  It  is  recommended to select  the audio input

device explicitly.

Input Line – audio mixer line used to connect a microphone.

Noise  Reduction – allows making dispatcher sound clearer by  reducing noises.  You can choose  several  levels

starting from 6 to 18 dB. If voice and noise levels are the same or close, do not enable noise reduction.

Audio Input Test – allows checking quality  of microphone performance.  To  test  your  microphone  performance,

click  Record  and  then  talk  into  the  microphone.  Stop  recording  by  clicking  Stop,  which  appears  instead  of

Record. To listen to what you have just recorded, click Check. You can also save the recording in MP3 format  by
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clicking Save. 

Audio Output – audio device to which headsets or speakers are connected.  To check quality  of the audio output

device performance, click Check. At that, you will hear a sound. To stop the sound, click Stop.

Codec – audio stream compression method.

Bitrate – audio stream sampling frequency.

VoIP Port – audio stream receive port.

Specifications of the codec format 8000 Hz, 20 ms, 64 (89) kbps:

8000 Hz – the sampling rate

20 ms – the frame size

64 kbps – the voice data bit rate

89 kbps – a full bit rate (required network bandwidth)
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Starting from version 8.3,  dispatch console allows you to set  up different  audio output  devices,  including multiple

channels,  for  different  subscribers,  talkgroups,  slots,  etc.  E.  g.,  you  can  listen  to  radio  subscribers  on  the

headset, and the external dispatcher on the speakers. To do that, open the Audio Output Devices tab.
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1. Add audio output devices in the first box on the left. These are not real output devices and are used only  in

dispatch  console.  To  do  that  click  on  Add.  A  new record  will  appear  on  the  list.  Change  its  name,  if

necessary, by clicking Edit, and then select it. 

2. In the  list  below,  select  the  real  devices  or  device  channels  which  will  correspond  to  the  added  output

device.
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3. In  the  Objects list  select  the  network  object,  for  which  you  want  to  set  up  the  new  audio  device  or

channel.  And in the Select Audio Output Device  dropdown list  select  the created output  device.  Thus,

you assign the audio output device or channel to a network object.

Note: Select Inherited if you don't  want  to set  the audio output  device explicitly.  In this  case the object  will  use

the audio output device which is assigned to the parent object.
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To assign another device to an object, you can do it in its Action List in the Subscriber Panels.
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The Other Settings tab:

Mute Mode – provides options for muting.

Basic – in this mode when you click  to mute the control station, the system will  work  in a standard way,  that

is you will hear nothing from the control station.

Advanced – in this mode when you click  to mute the control station, the system will work differently. You will

still  be  able  to  hear  private  incoming  calls,  calls  initiated  on  the  dispatcher  side  or  calls  answered  by  the

dispatcher.

Increase  Dispatcher  Sound  –  allows  user  to  adjust  the  volume  level  of  the  dispatcher  outgoing  call  on  the

receiving radio (to increase or decrease by the value of selected Level coefficient).

Unlike  the  microphone  volume  settings  in  the  equalizer  window,  the  microphone  volume  change  applies  to  all
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devices. Increase Dispatcher Sound regards only the radio receiving a dispatcher call.

2.5.11  Records

To set audio record settings,  expand the Settings menu in the Main Menu of the SmartPTT Dispatcher window

and click Record Settings. The Audio Record Settings window opens.

Record Calls – select this option to record all the incoming and outgoing calls.

Set sample rate to 8 kHz – select this option to set  the record quality  of the audio file with a sampling rate of 8

kHz. This setting allows you to reduce the size of the saved audio file due to no major loss in sound quality.

Recording Level of Outgoing Calls – increase or decrease the sound volume for recording outgoing calls.

Recording Quality (kbps) – sets sound quality for audio files.
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Folder for Audio Files Recording – sets the path to the folder with recorded audio files.

Audio Files Search Paths – sets paths to additional folders for recorded audio files.

Note:  After changing the folder path where audio files  are stored,  the  former  path  is  automatically  added  to  the

audio files search path field.

Audio Records Truncate Parameters – sets audio record cleaning parameters.

2.5.12  Positioning Systems

To set  GPS or Indoor settings,  expand the Settings menu  in  the  Main  Menu  bar  of  the  SmartPTT Dispatcher

window and click Positioning Systems. The Positioning Systems window will open.
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The GPS tab contains the following parameters:

Validity  of  GPS  coordinates –  sets  GPS  data  validity  period  in  minutes.  If  new  GPS  coordinates  were  not

received during this period, the subscriber's label is removed from the map.

Time interval for GPS coordinates update – time interval of sending requests for updated location data.

Accuracy  Radius –  sets  the  maximum  coordinate  error  margin.  If  the  received  error  value  exceeds  the  value

specified in this field, the coordinate is invalid.

Save GPS Locations in Database  – select  the check box to store GPS coordinates  received from subscribers

in the database.

GPS Coordinate Format – GPS coordinate format to display in the subscriber Call window:

Decimal degrees. GPS coordinates are displayed as: lat.: 56,47568, lon.:84,98779.

Degrees, Minutes, Seconds. GPS coordinates are displayed as: lat.: 56°28'32", lon.:84°59'16".

Universal  Transverse  Mercator  Coordinate  System.  GPS  coordinates  are  displayed  as:  45V  376108  B
6260913 C.

Speed Format – sets the display format of a radio subscriber's speed.

System of Units – allows selecting measurement system for distance (Metric or Imperial).

Note: When changing measurement  system, the data previously  logged  won't  be  recalculated  according  to  the

new measurement system.

Address Data  Provider  –  sets  the  map  service  (Google  or  OpenStreetMap),  which  will  determine  the  object

address on the map corresponding to the subscriber current GPS-coordinates.

Show Subscriber’s Information for Map Label – sets what information will be shown on a map label of a radio

subscriber.

Size of Subscriber’s Map Label – sets size of a subscriber's map label.

Color of Subscriber with Valid GPS Location – sets  color which will  be used for a radio subscriber with valid

GPS locations.

Hide  Map Labels with  Outdated  Locations –  select  the  check  box  to  hide  map  labels  for  subscribers  with

outdated  GPS  locations.  GPS  location  becomes  outdated  if  it  was  not  updated  during  the  period  set  in  the

Validity of GPS coordinates field.

Hide  Map Labels for Offline  Subscribers – select  the check box to hide map labels  when a  subscriber  goes

offline.

Database Cleanup Settings – defines the scheme of deleting coordinates from the database.
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The Indoor tab contains  only  one parameter.  Validity of beacon signals defines the  time  period  during  which

the received beacon signal is relevant. If new beacon signals were not received during this  period,  the subscriber's

label is removed from the building plan.

2.5.13  Telemetry

To  set  up  actions  based  on  incoming/outgoing  telemetry  commands,  expand  the  Settings menu  in  the  Main

Menu bar of the SmartPTT Dispatcher window and click Telemetry. At that, a configuration window is displayed.
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To add a new telemetry command, click Add. The Telemetry Settings window is displayed.

Description – description of the action to be triggered.

Contact – select a contact or VIO from the list.

Note: Make sure the selected contact or VIO is mapped to a physical GPIO line in MOTOTRBO CPS.

Direction – select direction (incoming or outgoing).

Action – action type: impulse, high level, low level, toggle level.

To save the changes click OK – the created settings appear in the list of settings.

To edit the existing settings, select the entry in the list of settings and click Edit.

To delete the settings, select the entry in the list of settings and click Delete.
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How to Assign Telemetry to the Radio Subscriber

You can select telemetry settings in the subscriber's Properties window.
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Click the Telemetry button to open the window for selecting available telemetry commands for the subscriber.

Select the required command to make it available in the Call  Window  of the radio subscriber and in the custom

consoles. Also, it allows you to set automatic  status  updates of the GPIO pins.  To receive status  updates of the

GPIO pins automatically, select the required GPIO pins in the Update GPIO pins' status area and set  the update

interval in seconds.

Note: Automatic GPIO pins' status update is applied only for incoming telemetry commands.

Then you can run the telemetry command from the subscriber's Call Window.
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To receive the current telemetry status, click . The updated status will be displayed in the Call Window of

the radio subscriber.

How to Assign Telemetry to the Talkgroup of Radio Subscribers

You can select telemetry settings in the Properties window of the talkgroup. 
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Click the Telemetry button and select available telemetry commands for the talkgroup.

Then you can run the telemetry command from the talkgroup Call Window.
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2.5.14  Categories

To create a category  structure,  expand the Settings menu in  the  Main  Menu  bar  of  the  SmartPTT Dispatcher

window and click Categories. The configuration window for setting up the category structure opens.
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Show "No Category" Folder – displays  a list  of all  online subscribers  (radio subscribers,  talkgroups) in the No

Category folder of the Radio Fleet panel (filter by category), without reference to categories.

To create a new category, click Add in the Categories window.

To edit the existing category  name, select  it  in the list  and click  Edit.  To remove a category,  select  it  in the list

and click Delete.

To  move  categories  inside  a  parent  category,  use  arrow button  on  the  right.  To  move  the  categories  between

levels, click on a category, hold the left mouse button and drag it to a new position.
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The categories are displayed in the Radio Fleet panel (filter by category  is selected).

Click the button  next to the category name to apply actions to all the subscribers from the category.
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Send Message to Category Subscribers – opens the window for sending messages.

Show  All  Subscribers in Category on Map – displays  all  subscribers  from  this  category  on  the  map,  if  it  is

opened.

Remove All Subscribers in Category from Map – removes all subscribers of this category from the map,  if it  is

opened.

View Properties – opens the Properties of category window. Also you can right-click  on the category  name in

order to open the Properties of category window.

The Properties of category window consists of three tabs: Common, Subscribers, Talkgroups.

The Common tab:

Name – the category name.

Status –  the  general  status  of  all  subscribers  in  the  category.  If  the  status  of  at  least  one  subscriber  in  the

category is changed, the category's general status becomes undefined.

Update  location  –  the  group  of  the  general  GPS-monitoring  settings  of  all  subscribers  in  the  category.  The

parameters of the general GPS-monitoring settings can have three possible states:

– Checked . Shows that the parameter is set for all subscribers in the category.

– Unchecked . Shows that the parameter is not set for all subscribers in the category.

– Mixed choice . Shows that the parameter is set for some subscribers in the category.
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The Subscribers tab  contains  the  list  of  all  subscribers  in  the  system.  In  order  to  assign  a  subscriber  to  the

category, select the appropriate check box in the list of subscribers.

The Talkgroups tab contains  the list  of all  talkgroups in the system. In order to assign a group to the category,

select the appropriate check box in the list of talkgroups.

Note:  Radio  subscribers  and  talkgroups   can  be  assigned  to  a  category.  However,  the  actions  applied  to  the

category members will be addressed only to radio subscribers.

2.5.15  Dispatchers

SmartPTT Dispatcher  allows  you  to  connect  to  other  dispatchers  who  use  the  SmartPTT  system.  But  before

connecting to other dispatchers you must check or do the following:

1. Make sure that the operator has the permission Connect with external  dispatchers (Settings >  Operators).

If not, the Dispatchers button   will  be unavailable in the Main Menu,  and calls  to other dispatchers  will

be impossible. 

2. Make sure that at least one dispatcher is added to the dispatchers  list  in Settings > Dispatchers.  If the list  is

empty,  the Dispatchers button   will  be unavailable in the  Main  Menu  even  if  the  permission  Connect

with external dispatchers is selected.
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To  set  up  connection  to  other  dispatchers,  expand  the  Settings  menu  in  the  Main  Menu  bar  and  click

Dispatchers.

VoIP Port —  UDP port of this dispatcher's PC for voice transmission. The default value is 18501.

Session Port – TCP port of this dispatcher's  PC for transmission of commands and text  messages.   The default

value is 18501.

Play Sound Alert for Incoming Call – select this check box to play a tone for an incoming call.

Play Sound Alert for Outgoing Call – select this check box to play a tone for an outgoing call.
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To add a new dispatcher, click Add.

Name – the dispatcher’s name displayed in the list of dispatchers.

Address – IP address of the dispatcher's workstation (DNS name can be used).

VoIP Port – UDP port for voice transmission.

Session Port – TCP port for transmission of commands and text messages.

Select – the path to the file of the dispatcher's photo.

Sound for Incoming Call  Alert – the path to the sound file which  will  play  in  the  dispatch  console  when  this

dispatcher calls.

To save the changes, click OK. At that, a new dispatcher is added to the list of dispatchers.

To edit dispatcher settings, select it in the list of dispatchers and click Edit.

To remove a dispatcher, select it in the list of dispatchers and click Delete.
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To call the dispatcher,  open the Dispatchers window by clicking the button  .  At  that,  the following window

opens.

On the left you can see available dispatchers with different statuses. These can be:

Offline  –  the  dispatcher  is  not  available  for  communication.  This  means  that  the  dispatcher  has  not  launched

SmartPTT Dispatcher, or does not have the permission (Connect with external dispatchers).

Online – the dispatcher is available for communication.

Ringing – calling to the dispatcher to establish voice communication.

Call – voice communication is established.

To call  a dispatcher,  select  it  from  the  list,  and  click  Connect.  To  end  the  call,  click  Disconnect  (this  button

appears as soon as you have started communication).

To add online dispatchers to a conference call, click .

To  mute  your  voice  transmission,  click  .  You  will  still  hear  the  other  dispatcher.  This  button  becomes

available when the call is started.

To send a message to the selected dispatcher, enter the text of the message and click .
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To answer or decline the incoming call from a dispatcher, click Accept or Decline in the opened window:

If the incoming call  is  made by the dispatcher not  on the list  you  will  see  its  IP  address  in  the  Incoming  call

window. You can add the unregistered dispatcher in the Dispatcher window by clicking on the Add button.
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2.5.16  Telephone Subscribers

To  view the  list  of  registered  telephone  subscriber,  expand  the  Settings  menu  in  the  Main  Menu  and  click

Telephone  Subscribers.  The  list  includes  all  telephone  subscribers  that  support  SIP  connection.  You  can

modify and delete existing subscribers, or add new subscribers.
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Note:  SIP  connection  can  be  established  also  with  telephone  subscribers  not  added  to  the  list.  To  make  an

outgoing call, you can use a dial pad.
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To add a telephone subscriber to the list of subscribers, click Add. At that, the following window opens.

Subscriber – type the name of telephone subscriber.

The SIP Address area allows you to specify the telephone subscriber address.

There are several options to enter the address of the subscriber.  First,  the outgoing and incoming address fields

can be generated automatically using the default gateway settings. To do that, click Automatic. 

Second,  you can enter the addresses manually  by  clicking Full  Address (use  the  following  format  –  sip:prefix

number@gateway:port).

Select the Enable SIP Account check box and specify the required SIP account from the list of available to carry

out  SIP  connection  under  the  set  account.  For  SIP  account  setup  details  in  SmartPTT  Dispatcher  see  SIP

Accounts.

Sound for Incoming Call  Alert – the path to the sound file which  will  play  in  the  dispatch  console  when  this

telephone subscriber calls.

Click OK to save the changes.

As  soon  as  you  have  added  a  new telephone  subscriber,  it  appears  in  the  Telephone  Subscribers  window.

Please remember that  the Allow  Calls to Telephone  Subscribers check box in the Telephone  Interconnect

window must be selected.

To edit or delete the telephone subscriber from the list, click the corresponding button.
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2.5.17  Telephone Interconnect

SmartPTT Dispatcher has a built-in function  to  make  telephone  connections  with  telephone  subscribers.  A  call

can  be  initiated  both  by  the  dispatcher  and  the  telephone  subscriber.  Standard  VoIP  gateways  are  used  to

connect to telephone subscribers. The following connection options are possible:

1. The dispatcher calls the office PBX subscriber and voice is transmitted in full-duplex mode.

2. The office PBX subscriber calls the dispatcher and voice is transmitted in full-duplex mode.

3. SmartPTT Dispatcher connects telephone and radio subscribers.

Connection  and  subscriber  addressing  are  implemented  via  SIP  protocol.  Voice  data  is  transmitted  via  RTP

protocol.

The connection scheme:

A  VoIP  gateway  is  a  device  which  bridge  conventional  telephone  networks  and  equipment  to  VoIP  telephone

networks.

A Private Branch eXchange (PBX) is a telephone exchange that serves a particular business or office.

The Public  Switched Telephone Network  (PSTN)  is  the  network  of  the  world's  public  circuit-switched  telephone
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networks. 

SIP Architecture

Call service management is  distributed between different  elements  of SIP network.  The basic  functional unit  that

implements  connection  management  are  User  Agents,  which  are  endpoints  of  a  call  (that  is  each  of  the

participants  in  a  call).  The  remaining  network  elements  (SIP-servers)  are  responsible  for  call  routing  and  can

provide additional services. 

1. User Agents

User agents are both the computer that is being used to make a call, and the target computer that is being called.

These make the two endpoints of the communication session. There are two components to a user agent:  a client

and  a  server.  When  a  user  agent  makes  a  request  (such  as  initiating  a  session),  it  is  the  User  Agent  Client

(UAC), and the user agent responding to the request  is  the User Agent  Server (UAS).  Even though other devices

that we’ll discuss are optional to various degrees, User Agents must exist for a SIP session to be established.

2. Proxy Server

Proxy  servers  are  computers  that  are  used  to  forward  requests  on  behalf  of  other  computers.  If  a  SIP  server

receives  a  request  from  a  client,  it  can  forward  the  request  onto  another  SIP  server  on  the  network.  While

functioning  as  a  proxy  server,  the  SIP  server  can  provide  such  functions  as  network  access  control,  security,

authentication, and authorization.

3. Registrar Server

Registrar servers are used to register the location of a user agent who has logged onto the network.  It  obtains  the

IP address of the user and associates it with their user name on the system. This  creates  a directory  of all  those

who are currently  logged onto the network,  and  where  they  are  located.  When  someone  wishes  to  establish  a

session  with  one  of  these  users,  the  Registrar  server’s  information  is  referred  to,  thereby  identifying  the  IP

addresses of those involved in the session.

4. Redirect Server

The Redirect servers are used by SIP to redirect clients to the user agent they are attempting to contact.  If a user

agent  makes a request,  the Redirect  server can respond with the IP address of the user agent  being contacted.

This is different from a Proxy server, which forwards the request  on your behalf,  as  the Redirect  server essentially

tells you to contact them yourself. 

SIP determines the following addressing system: [sip:] id [@ fragment]. ID indicates user name or phone number

of  the  subscriber.  Fragment  specifies  the  host,  which  can  be  set  to  the  domain  name,  the  IP-address  of  the
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computer  or  the  address  of  the  VoIP  gateway.  Caller  ID  can  be  presented  in  different  ways,  such  as

user_name@[domain name], name@[IPaddress], phone_number@[VoIPgateway].

SIP Connection Methods

There are two SIP connection types – SIP trunking and using a SIP account.

SIP  trunking  is  used  when  a  user  agent  (SmartPTT Dispatcher  in  our  case)  has  a  static  IP  address.  This  IP

address must  be prescribed on SIP server only  once,  and  the  client  does  not  require  to  re-register  on  the  SIP

server. SIP trunking provides security by means of password authentication for incoming and outgoing calls.

If the client  IP address  changes  periodically,  use  a  SIP  server  account  to  establish  the  connection.  When  the

client turns on, it sends a special package for SIP registration to the server.  The package contains  authentication

data (SIP account  user name, login,  password)  and  the  current  IP  address.  Since  then  server  knows  where  to

route calls addressed to the client. After a period of time the client  automatically  updates the registration.  If its  IP

address has changed, SIP server accordingly updates the information on this user.
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Telephone Interconnect Configuration

To configure connection parameters  with telephone subscribers,  expand  the  Settings menu  in  the  Main  Menu

bar of the SmartPTT Dispatcher window and click Telephone Interconnect.

The Telephone Interconnect window includes:

1. General settings

2. Codec settings

3. SIP Trunk Authentication

4. SIP accounts

General Settings

The General Settings tab includes Dispatcher Settings and VoIP Gateway Default Settings sections. 

1. Dispatcher Settings

Allow  Calls to Telephone  Subscribers – select  the check box to be able to make and  receive  calls  between
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SmartPTT Dispatcher and telephone subscribers. 

Note: If the check box is not selected, the Telephone Subscribers window is unavailable.  

RTP Ports – each connection with the telephone subscriber requires two UDP ports  (even port  numbers  are used

by RTP protocol, uneven – by RTCP). Thus,  the specified ports  must  be available both for incoming and outgoing

traffic. The default port range is 18700–18748.

Warning! If both SmartPTT Dispatcher and SmartPTT  Radioserver  are  installed  on  one  computer,  the

port range set in the "RTP Ports" field in SmartPTT Dispatcher must differ from the  port range  set in the

"RTP ports" field in SmartPTT Radioserver Configurator. 

Interface  –  IP  address  of  the  local  computer,  used  to  receive  and  transmit  commands  and  voice  data.  If  the

dispatcher's computer has only one IP address, the system can select it automatically; if it  has more than one IP

address,  the IP address  (interface)  should  be  specified  expressly.  The  specified  IP  must  be  available  from  the

VoIP gateway end.

Warning! If  several  network  interfaces are  installed  on  the  computer  you  may  have  to  configure  the

routing table using the command "route add ...".

SIP  Port  –  UDP  or  TCP  port  number  to  receive  and  send  SIP  data  packets.  The  default  value  is  5060.

Accordingly, the specified port must be available for incoming and outgoing traffic.

Warning! If both SmartPTT Dispatcher and SmartPTT Radioserver are  installed on one  computer,  their

SIP ports must differ. In this example it must be 5061 because 5060 is already taken by the radioserver.

Displayed  Telephone  Number  –  type  the  telephone  number  which  allows  you  to  connect  to  SmartPTT

Dispatcher. This number is also displayed on the screen of the receiving SIP call device (phone or softphone).

Subscriber  Name  –  type  the  name  to  be  displayed  on  the  screen  of  the  receiving  SIP  call  device  (phone  or

softphone).

2. VoIP Gateway Default Settings

If VoIP Gateway Default Settings are specified, it is enough to set only subscriber phone numbers in the List of

Subscribers tab. Also, these parameters are used to dial the called subscriber number manually  (click  the  Dial

Pad button and the Dial Pad window opens).

Default VoIP Gateway Address – the VoIP gateway IP address.
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SIP Port – a VoIP gateway to receive and send SIP data packets.  By default  VoIP gateways use the UDP port

5060.

Dial Prefix for Outgoing Calls – numeric prefix added to the called subscriber number by  SmartPTT Dispatcher.

VoIP gateway uses the prefix  to  determine  where  the  call  came  from  and  what  rules  it  must  apply  to  the  call

(block or allow, where the call must be routed).

Dial Prefix for Incoming Calls – numeric prefix value in this field must match the same VoIP gateway prefix. 

If default VoIP gateway is used, the telephone subscriber's complete SIP address will be as follows:

SIP address = Dial Prefix for Outgoing Calls + Phone Number + @ + Default VoIP Gateway Address + : +

Gateway SIP Port.

 Example:

 If the following settings are used:

 Default VoIP Gateway Address = 192.168.0.243

 SIP Port = 5060

 Dial Prefix for Outgoing Calls = 12

 The  telephone  subscriber  with  the  phone  number  1140  is  automatically  assigned  the  following  outgoing  SIP

address = 121140@192.168.0.243:5060.

Note:  If your network  uses a firewall,  consult  a network  administrator about  the possibility  of  using  SIP  protocol

and  the  required  settings.  The  most  common  problem  is  that  the  media  streams  (for  example,  voice)  are

transferred  over  dynamically  assigned  UDP  ports  that  are  generally  closed.  The  firewall  must  be  able  to

dynamically open and close ports based on the transferred SIP signaling.  Another problem is  that  the SIP clients

inside the firewall cannot  be reached by IP addresses since these most  often are  private  and  local  to  the  LAN.

Communication simply does not take place, unless there is specific SIP support in the firewall.

Play  Sound  Alert  for  Incoming  Call  –  select  the  check  box  to  enable  ringing  at  the  SmartPTT  Dispatcher

application when a telephone subscriber calls.

Play  Sound  Alert  for  Outgoing  Call  –  select  the  check  box  to  enable  ringing  at  the  SmartPTT  Dispatcher

application when making a call to a telephone subscriber.

Listen to Subscriber Conversation – select  the check box to allow the dispatcher to listen to the conversation

between the radio and telephone subscriber.

Sound  Level  –  allows  you  to  configure  the  sound  level  in  the  dispatch  console  coming  from  the  telephone
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subscriber.

3. VoIP Gateway Configuration

The VoIP gateway administrator must  ensure that  SIP addresses for incoming calls  are appropriately  interpreted

and switched to phone numbers.

In the example above the telephone subscriber address is  sip:121140@192.168.0.243:5060 and the dial prefix  for

outgoing calls is 12. Therefore VoIP gateway rules  must  discard the incoming prefix  12 from the full  address and

connect the dispatcher to the telephone subscriber number, that is 1140.

You should also configure appropriate generation rules for outgoing SIP addresses to call other dispatchers.

For example, if the telephone subscriber with the number 1140 assigned wants  to connect  to the dispatcher with

the address 192.168.0.105:5060,  then  generation  rules  for  outgoing  SIP  addresses  on  the  VoIP  gateway  must

generate the correct  destination address sip:1@192.168.0.105:5060  (the  Displayed  Telephone  Number  value

must  be  set  as  the  SmartPTT  Dispatcher  identifier)  and  the  sender's  correct  address

sip:1140@192.168.0.243:5060  (a  dial  prefix  for  incoming  addresses  is  not  set  so  the  name  in  the  sender's

address is the same as the phone number).

Codec Settings

In the Codec Settings tab you can enable or disable supported audio codecs,  as  well as  change their priorities.

Currently, there are 4 audio codecs: G711A, G711Q, SPEEX и G729.
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SIP Trunking Authentication

The Telephone Interconnect window contains authentication settings in a separate tab.

Incoming Call Authentication – the setting includes parameters required for incoming call  authentication.  When

an incoming call from a phone/softphone is  received,  dispatcher asks user name and password corresponding to

Realm  in the described setting.  Calling  subscriber  must  send  back  user  name  and  password  specified  in  this

setting. The authentication type is not required if the incoming call  is  addressed to subscriber using SIP account

for connection. To activate this ability, select the Enabled check box.

Realm – parameter used for the incoming telephone calls authentication.

User Name – name of the user used for authentication.

Password – password used for authentication.

Outgoing Call Authentication – the setting includes parameters required for outgoing call authentication.

Realm  – if not  set,  SmartPTT Dispatcher responds to any any authentication request  with  specified  user  name

and password.  If set,  SmartPTT Dispatcher  responds  only  to  authentication  requests  that  matches  the  Realm
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value. 

User Name – user name used for authentication.

Password – password used for authentication.

SIP Accounts

If SmartPTT Dispatcher IP address varies, there must be a mechanism for determining its current value. In order to

do this, SIP registration can be used, allowing the dispatcher to inform SIP server of its actual IP address. 

For example, Client 1 has current IP address 192.168.0.224, Client 2 – 192.168.0.98.  It  is  necessary  to establish

connection between them, while both subscribers  are not  aware of each other's  IP addresses.  To do this,  create

accounts  on  SIP  server  (sip_server.com)  for  both  subscribers  –  user1  (sip:  user1@sip_server.com)  and  user2

(sip: user2@sip_server.com) respectively. SIP server stores current  IP addresses relevant  to the SIP accounts  of

Client  1 and Client  2.  Therefore,  Client  1 is  not  required to know current  IP  address  of  Client  2  to  make  a  call.

Client  1  refers  to  the  SIP  server  under  its  account  and  requests  connection  with  Client  2  pointing  out  its  SIP

account.  The  SIP  server  searches  its  database  for  the  current  IP  address  of  Client  2,  returns  it  to  Client  1  or

redirects the call from Client 1 to Client 2.

The SIP Accounts tab in the Telephone  Settings window contains  dispatcher SIP account  parameters.  These

accounts are created by the dispatcher on various SIP servers  in advance.  The parameters  are used to establish

connection with other server subscribers.

The  Status  field  displays  the  account  registration  status  on  SIP  server.  Possible  values  –  Registered,  Not

registered, Processing, and SIP error messages.
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To add a record about a new SIP account, click Add. At that, the following window opens.

Active – select this check box to enable account registration on SIP server.

Display Name – the name that appears on the subscriber device screen.

Username – the account identifier on the SIP server. 

SIP server – remote SIP server IP address.

Proxy – proxy server which can be used for special cases (for example,  some providers  insist  on using proxy to

request SIP server).

Domain – parameter for SIP server account authentication.

Login – login for SIP server account authentication.

Password – password for SIP server account authentication.

Registration Renewal Timer – time period (in seconds) between requests  for the dispatcher IP address update

on the SIP server.

 The following example is focused on setting up connection between SmartPTT Dispatcher (Dispatcher 1) and two

other SIP clients (Linphone, MicroSIP, 3CX, or SmartPTT Dispatcher) (Dispatcher 2, Dispatcher 3). These settings
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allow Dispatcher 1, Dispatcher 2, and Dispatcher 3 to interact with one another as 3CX server subscribers.

In order to do this:

1. Create SIP accounts for three SIP clients using the selected VoIP service provider,  for example,  accounts  with

ID = 105, 106, and 107 on the 3CX SIP server.

2. In the SIP Accounts tab,  as  Dispatcher 1 add records corresponding to the created SIP server accounts  with

ID = 105; Dispatcher 2 – with ID = 106; Dispatcher 3 – with ID = 107.

3. As  Dispatcher  1  add  records  of  the  two  subscribers  (Dispatcher  2,  Dispatcher  3).  Connection  with  these

subscribers will be established via SIP server accounts.

Add the new subscribers in the Telephone  Subscriber window. Fill  in the Subscriber field.  Click  Full  Address

(Automatic can also be selected if VoIP Gateway Default Settings allow you to connect  to  the  selected  SIP

server) and specify  the outgoing and incoming SIP addresses corresponding to the called subscriber.  Select  the

Dispatcher 1 SIP account in the Enable SIP Account field (see step 2).

Created subscriber entries appear in the Telephone Subscribers window.

4.  Complete  the  same  settings  for  Dispatcher  2  (create  account  with  ID  =  106  in  the  SIP  accounts  tab;  add

subscribers 105 and 107 in the List of Subscribers tab) and Dispatcher 3 (create account  with ID =  107 in the
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SIP accounts tab; add subscribers 105 and 106 in the List of Subscribers tab).
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5. To apply settings, click Finish in the Telephone Settings and in the Telephone Interconnect windows.

How to Call a Telephone Subscriber

To call the telephone subscriber from the dispatch console, click the button :

At that you will see the following window:
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To call the telephone subscriber, select it from the list and click Connect. In the Telephone subscribers tab you

can see not only added telephone subscribers,  but  also unregistered telephone subscribers  (their numbers  are in

italics),  and  three  latest  calls  (at  the  top  of  the  list).  You  can  add  the  unregistered  telephone  subscriber  by

clicking on the Add button which appears when an unregistered telephone subscriber is selected.

is  used for running a conference call  with the selected telephone subscriber.  For more  information  about  this

function see Conference Calls.
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To make a call  to a  telephone  subscriber  not  on  the  list,  go  to  the  Dial  Pad  tab.  You  can  dial  the  telephone

number or enter it in the input field above the dial pad.

If you need to dial an extension to reach a telephone subscriber, do the following: 

1. Dial  the  phone  number  after  which  you  will  need  to  add  the  extension.  Then,  you  will  see  a  new  tab

Extension Dialing.



173Settings

Dispatch Console User GuideSmartPTT PLUS 8.7

2. In this tab, dial * to turn on DTMF mode (not obligatory, depends on the telephone parameters).

3. Dial the extension number and then #. 

To  connect  a  radio  subscriber  or  a  talkgroup  to  a  telephone  subscriber,  open  the  Call  Window  of  the  radio

subscriber or the talkgroup and click the Call Telephone Subscriber button.

You can also use Actions List, where you can select  Call  Telephone  Subscriber.  At  that  the following window

will open.
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Select the telephone subscriber from the list and click Connect or double-click  on the list  item. This  list  is  taken

from the list of telephone subscribers  created in the Telephone  Subscribers window. If the subscriber is  not  on

the list, click Dial Pad to enter the telephone number manually.

At clicking Connect, a new window with the call status opens.

There are three statuses:

Ringing

Call

Call Complete

If the connection attempt is failed, status window shows the corresponding error message.

To manage the call process, the dispatcher can use the buttons next to the call status:

 - stops the call. Should the radio subscriber make a call  right  after the telephone call,  it  is  necessary  for him
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or her to wait for a special tone notifying about  the end of the call.  If the radio subscriber presses the PTT button

before this tone, an incorrect phone call will be initiated.

 - initiates reconnection to the telephone subscriber.

2.5.18  Job Ticket Statuses

Here you can create job ticket statuses and specify their settings. For example, assign a color to a status  or add

alert on status change.

To  create  job  ticket  statuses,  expand  the  Settings menu  in  the  Main  Menu  bar  of  the  SmartPTT Dispatcher

window and click Job Ticket Statuses. At that, the following window opens.

Enable  Automatic Numbering –  when  this  option  is  enabled,  a  unique  number  is  assigned  to  each  new job

ticket. It is necessary to distinguish job tickets with same names.

Send notification to subscriber when uncompleted job ticket was deleted by dispatcher – if this  option is

enabled, a radio subscriber receives a message, if an incomplete job ticket was canceled.

Default Status – the job ticket status which is  displayed when the operator creates  a new job ticket.  The status
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does not change, until the radio subscriber modifies it. You do not need to set this status in the MOTOTRBO CPS

settings. It is used only in SmartPTT Dispatcher, so you can add any value you like.

In the Color field select the color for the default status.

To add a job ticket status, click Add.

Name – name of the status.

Color – color of the status, which will be used in the job ticket table.

Completion status – it  is  the final status  of a job ticket.  If a  job  ticket  has  such  a  status  and  if  Remove  job

ticket from the list within n seconds after completion is enabled, the job ticket will be hidden from the list.

Note: You can also select the Completion status later in the Job Tickets configuration window.

Sound – this setting enables the sound signal which will notify the operator that a job ticket changed its status.

Warning! Added statuses must match the statuses set in MOTOTRBO CPS.

If the statuses of SmartPTT Dispatcher does not  correspond to statuses in MOTOTRBO CPS, all  settings (color,

sound signal and status completion) won't be applied. 
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2.5.19  Third-Party Equipment

SmartPTT system  supports  third-party  equipment  e.g.,  Tipro  modular  console  with  BeFREE  touchcomputer  or

without it.

To make the console work with SmartPTT system, take the following steps:

1. For Tipro modular console with BeFREE touchcomputer,  install  the SmartPTT application and other additional

software,  such as  ChangeMe Utility,  Tipro OPOS (these are  delivered  together  with  Tipro  console),  Microsoft

Point  of  Service  for  .NET  (POS  for  .NET)  v1.14  (http://www.microsoft.com/en-us/download/details.aspx?

id=42081).

2. For Tipro modular console without touchcomputer,  connect  Tipro console to the PC with SmartPTT Dispatcher

installed. Install other additional software, such as ChangeMe Utility,  Tipro OPOS (these are delivered together

with Tipro console), Microsoft Point  of Service for .NET (POS for .NET) v1.14 (http://www.microsoft.com/en-us/

download/details.aspx?id=42081).

3. Contact SmartPTT support team (http://support.smartptt.com/hc/en-us/requests/new) for Tipro configuration file.

4. Apply the received Tipro configuration file using ChangeMe Utility.

5. Configure SmartPTT Dispatcher settings connected to Tipro support. 

The SmartPTT Dispatcher configuration includes the following steps:

1. Open SmartPTT Dispatcher.

2. Enable  Tipro  console.  On  the  Settings  menu  select  Third-Party  Equipment  and  then  select  Tipro

Console. In the opened window, select Enable.

http://www.microsoft.com/en-us/download/details.aspx?id=42081
http://www.microsoft.com/en-us/download/details.aspx?id=42081
http://www.microsoft.com/en-us/download/details.aspx?id=42081
http://www.microsoft.com/en-us/download/details.aspx?id=42081
http://support.smartptt.com/hc/en-us/requests/new
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At that,  the version of the main Tipro module appears,  and the settings become enabled.  If  device  can't  be

found, the settings are disabled.

3. Set  up sound settings.  You can  go  to  the  Sound  Settings by  clicking  on  Open  General  Settings to

change the current sound settings. You can also configure sound settings for the telephone module.  This

is necessary only for Tipro modular console with BeFREE touchcomputer. 

4. Add hot keys. To do that, open the Hot Keys tab.
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In the Subscribers and Actions box select  the subscriber,  subscriber group,  dispatcher or action,  to which

you want to assign a Tipro key. Then click  on Set and press the required Tipro key.  To save changes,  click

on Finish. To get back to previous settings, click Cancel. 

Reset All – removes all assigned hot keys.  

2.5.20  Hot Keys

SmartPTT Dispatcher implements  the ability  to make a call  to subscribers  (radio subscriber,  talkgroups,  all  call,

telephone  subscriber,  external  dispatcher)  by  clicking  on  a  predetermined  keyboard  key,  its  combination  or  a

button  of  the  external  input  device.  Also,  dispatcher  can  repeat  the  last  outgoing  call  or  respond  to  the  last

incoming call by pressing the hot keys.
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In order  to  set  up  hot  keys  for  system  subscribers,  expand  the  Settings menu  in  the  Main  Menu  bar  of  the

SmartPTT Dispatcher window and click Hot Keys.

The window contains  a list  of subscribers  available for  the  hot  key  assignment  –  radio  subscribers,  talkgroups,

telephone subscribers,  external dispatchers,  last  called and last  active subscribers.  To  assign  a  hot  key  to  the

subscriber, select the subscriber from the list, then select the hot key type.

Keyboard – select the field to assign to the subscriber a keyboard key or a key combination as  the PTT button.

Click Select, then press the keyboard key or the key combination.
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Not all keyboard keys can be used as hot keys. Here is the keyboard scheme. It shows which keyboard keys can

be used and which cannot.

1. The keyboard keys marked red cannot be used as hot keys separately or in combination.

2. The keyboard keys marked yellow cannot  be used as  hot  keys separately,  only  in combination with the  Ctrl,

Alt or Shift keys. The Shift key can be used only in combination of three keys, for example, Shift+Alt+F.

3. The Esc key can be used only in combination with Shift (Shift+Esc).

4. All other keyboard keys can be used as hot keys either separately or in combination with the Ctrl,  Alt or Shift

keys.  The Shift key  can be used in combination of two  or  three  keys,  for  example,  Shift+Delete,  Shift+Alt

+Enter.

Note: Hot keys support two work modes: holding and single press. The active mode is defined in Contol Devices.
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External  Device  – select  the field to assign to the subscriber a key of the  external  input  device  connected  via

USB as the PTT button.  Select  the external device from the list  of available,  click  the Select button,  then press

the key of the external device.

External  Device  COM  Port  –  select  the  field  to  assign  to  the  subscriber  a  key  of  the  external  PTT  pedal

connected via COM port as the PTT button. Select the COM port of the PTT pedal from the list of available.

There is only one mode available for the PTT button on external devices – hold to enable.

To  remove  the  previously  defined  hot  key  for  the  subscriber,  disable  the  appropriate  check  box.  To  reset  the

assigned hot keys for all subscribers, click Reset All.
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If a designated keyboard key or button of an external input  device is  already in use,  the message appears  in the

window:

A keyboard key or a  key  of  the  external  input  device  which  is  already  in  use  as  the  PTT  button  for  a  current

subscriber cannot be used as a PTT button for the selected subscriber.

Note: The PTT button used for a call to a current subscriber means that you use this button to call  any subscriber

of SmartPTT Dispatcher.
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Note: If the hot  key that  you set  matches the PTT button for the current  subscriber,  the hot  key settings will  be

discarded.

Click Finish to apply the settings. To get back to the previous settings, click Cancel.

2.5.21  Database Auto Backup

Backing up data on a regular basis helps to protect it from being erased in case of the server hardware or software

failure. SmartPTT Dispatcher allows the Administrator to back up the database manually  or to set  up parameters

for automatic backup.
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In order to set up automatic  backup parameters,  expand the Settings menu in the Main Menu bar of SmartPTT

Dispatcher and click Database Auto Backup.

Allow  Database  Auto  Backup  –  select  the  check  box  to  enable  the  ability  to  create  SmartPTT  Dispatcher

current database backups in the automatic mode. 

Backup Folder – full path to the file for saving the database backup.

Backup Settings – schedule for creating the current database backup:

Daily – every fixed day at the specified time (for example, every day, every third day at 9:00 a.m.).

Weekly – every fixed day of the week at  the specified time (for example,  every  Monday,  Wednesday and

Friday at 11:00 p.m., or every Monday at 11:00 p.m. and Friday at 11:00 a.m.).

Monthly – once a month on the fixed day of the selected month and at the specified time.

Backup Period – allows you to set time period when automatic database backup is  to be made according to the
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selected backup settings.

Note. The number of stored backup files in the same folder is  limited to 3.  Otherwise,  when creating a new copy,

the old files are deleted.

Note. To restore the database from the automatically created backup, see Database.

2.5.22  Rules and Alerts

You can set response rules for the events registered in SmartPTT system. Response rules may include automatic

sending of messages, playing alerts  in SmartPTT Dispatcher and on the radio,  changing radio subscriber status,

etc. 



187Settings

Dispatch Console User GuideSmartPTT PLUS 8.7

To set  rules,  expand the Settings menu in  the  Main  Menu  bar  of  the  SmartPTT Dispatcher  window and  click

Rules and Alerts. The configuration window opens up.
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To add a new rule, click Add. The window with rule settings opens up.

Name – the name of the rule.

Active – select this check box to make the rule enabled.

The following table presents conditions that can be used in rules.

Attribute Operation Value

Direction No, Equals Incoming, Outgoing

Event Type No, Equals, Not Equals Registration,  Call,  Message,  Telemetry,

Alarm,  Status,  Block  Radio,  Job  Ticket,

Lone Worker
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Date/Time No, In Interval Time interval

Additional Information No, Equals, Contains Type  event  additional  information,  e.  g.

text  messages,  titles  and  description  of

tasks, talkers from a group call.

Not Read No, Equals Read, Not Read

Operator No, Equals, Not Equals Operator from list of operators

Radioserver No, Equals, Contains Radioserver name

Control Station No, Equals, Contains Control station name

Subscriber No, Equals, Not Equals Subscriber from the list of subscribers

Talkgroup No, Equals, Contains Talkgroup name

Status No, Equals, Not Equals Status from the list of statuses

Duration No,  Equals,  Not  Equals,

Greater,  Greater  than  or  Equal,

Less,  Less  than  or  Equal,  In

Interval

Duration in seconds

Connection Type No, Equals, Not Equals Connection types used in SmartPTT:

DMR – over-the-air connection made via

repeaters and control stations;

PBX – telephone connection

IP – Dispatcher-Dispatcher connection.

Repeater IP No, Equals, Not Equals Available repeaters' IP addresses

Receiver No, Equals, Not Equals Subscriber from the list of subscribers

Record No, Equals Available audio records

Attribute – contains the list of existing events which the system can register.

Operation – list of possible system operations for this attribute.

Value – values that can be selected for the attribute.

The  rule  is  a  combination  of  an  attribute,  operation  and  value.  One  rule  can  contain  more  than  one  such

combinations.



190Settings

Dispatch Console User GuideSmartPTT PLUS 8.7

When the system has registered an event matching the specified rule, the system performs predefined actions:

1. Alerts addressed to the initiator

2. Alerts addressed to the dispatcher

3. Alerts addressed to the radio subscriber

4. Other

The Message Format tab allows you to set the format of the alert massages.

To save the rule, click OK. At that, the created rule appears in the list of rules.

To edit the rule, select it in the list of rules and click Edit. To remove the rule, select it in the list  of rules  and click

Delete.

Initiator Alert

Open the Initiator Alert tab.  In this  tab you can set  up actions that  will  be performed  if  the  rule  conditions  are

fulfilled.

Block Radio – if selected, the radio that triggered the rule, will be blocked.

Lone Worker – if selected and On clicked, the lone worker profile will be set to the radio that  triggered the rule.  If

Off is clicked, the lone worker mode of the radio will be deactivated.

Note: To set up the lone worker profile, see Lone Worker Rules in SmartPTT Dispatcher.

Message – a text message is sent to the subscriber who initiated triggering of the rule. You can specify  message

format settings in the Message Format tab.

Dispatcher Alert
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Open the Dispatcher Alert tab.

Play Sound – select .wav audio file to play.

Show on Map – location of the subscriber specified in the rule is shown on the map (with an icon).

Alert – notification with the event description is displayed in the System Notification window. You can define the

title in the Alert Caption field and the description in the Alert Text field.

Set Subscriber Status – the subscriber is  assigned the predefined status.  It  is  selected from the  Statuses list

(see Statuses).

Subscriber Alert

Open the Subscriber Alert tab.

Send Message – a text message is sent to the selected subscribers,  talkgroups or categories.  You can specify

format settings of text messages in the Message Format tab of the Actions area.

Other
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Open the Other tab.

HTTP Request – is used for notification of the third party  server of the changes occurred in SmartPTT system. It

can render the event initiator radio ID and its status. 

The HTTP request includes the following parts:

Note:  Make sure that  you have  specified  correct  names  for  parameters  1  and  2.  They  must  correspond  to  the

parameters' names expected by the third party server.

Note:  Under "@Status"  SmartPTT system will  send the system  message  corresponding  to  the  newly  assigned

status selected in the Dispatcher Alert tab. Status system messages are set in the Statuses settings.

E-mail – is used for specifying e-mail address where a message should be sent in case the rules  specified earlier

are not fulfilled. To do this, the following fields are to be filled:

Radioserver – server name which is  configured for e-mail sending.  The name of the server is  selected  from  the

drop-down list.

E-mail – electronic addresses to send messages.

Message – text of the message.

SMS – if selected, the SMS message is sent to the specified phone number in case the rules specified earlier are
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not fulfilled. To do this, the following fields are to be filled:

Radioserver – server name for SMS messages sending.  The name of the server is  selected from the drop-down

list.

Phone  Numbers  –  telephone  numbers  to  send  SMS.  The  preferred  number  format  is  International  Number

Format, i.e. <+><country code><mobile code><phone number>.

Message – text of the message.

Note:  See  information  about  SmartPTT Radioserver  configuration  for  sending  and  receiving  e-mails,  and  SMS

messages in SmartPTT Radioserver Configurator Help under Telephone Interconnect and SMS Gateway.

You can specify format settings of SMS or E-mail messages in the Message Format tab of the Actions area.

Message Format

You can specify  message format  (text  messages,  SMS, or E-mail) in the Message  Format  tab  of  the  Actions

area.  These  messages  are  sent  to  radio  subscribers,  defined  in  the  message  recipient  list  in  the  Subscriber

Alert or Other tab.

Note: The format settings for text messages are valid for specific messages, only if Send Message  is  selected in

the Subscriber Alert tab; for SMS – if SMS is selected in the Other tab; for E-mail – if E-mail  is  selected in the

Other tab.

Event Information:

Event Type – if selected, the message includes the type of the event, which triggered the rule.

Date/Time – if selected, the date and time of the event  will  be added to the text  message.  You can set  the date

format displayed in the message (date and time, or time only).
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Time Zone – if selected, the message includes subscriber time zone in Coordinated Universal Time (UTC).

Coordinates – if selected, the subscriber coordinates  are displayed in the message.  Coordinates  are relevant  to

the moment, when the rule conditions were fulfilled.

Subscriber Information:

Subscriber  ID  –  if  selected,  the  ID  of  the  subscriber,  who  has  triggered  the  rule,  will  be  added  to  the  text

message.

Subscriber Name – if selected, the name of the subscriber, who has triggered the rule,  will  be added to the text

message.

2.5.23  Positioning Rules

You  can  set  response  rules  for  GPS  and  Indoor  events  registered  in  SmartPTT  system.  GPS  events  include

receiving  or  not  receiving  subscriber’s  GPS  coordinates,  and  Indoor  events  include  receiving  or  not  receiving

positioning  data  from  special  beacons.  Response  rules  may  include  automatic  sending  of  messages,  playing

alerts in SmartPTT Dispatcher and on the radio, changing radio subscriber statuses, etc. 
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To set up a positioning rule, expand the Settings menu in the main menu and click Positioning Rules.
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To add a new rule, click Add. In the window that opened specify parameters of the future rule.

Name – name of the rule.

There can be two kinds of positioning rules: Indoor and GPS. 

Type – rule types:

Stop control  – this  rule type checks if a radio subscriber is  moving,  i.e.  the  subscriber's  coordinates  or
Indoor positioning data constantly change with time.

Location data received – this rule type checks the appearance of the radio subscriber's coordinates after
a predefined period of time when there were no coordinates.

No location data  – this  rule type checks if there are no radio subscriber coordinates  for a period  longer
than the specified period of time. Coordinates like "...Lat: 0 Long: 0" are not  regarded as valid coordinates,
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and they won't be taken into account when applying positioning rules.

Zone/route entry – this rule type checks if the radio subscriber has entered the zone or the route,  i.e.  the
subscriber's previous coordinates  were outside the defined zone or route,  and the current  coordinates  are
within this zone or the route.

Zone/route exit – this rule type checks if the radio subscriber has left the zone or the route.

Speeding –  this rule type checks if there was any speeding based on the receives GPS data.

Number  of  subscribers  in  geofences  /  on  routes  –  this  rule  type  checks  the  number  of  radio
subscribers in the selected geofences or on selected routes.

Active – if the check box is  selected,  processing of events  starts  in accordance with the selected criteria.  If the

check box is not selected, the rule is unavailable.

The table lists the criteria used in positioning rules.

Attribute Value

All subscribers

Select  Subscribers  /  Select

Categories

Select  all  subscribers,  or some  subscribers,  or  categories,  to  whom

the rule will be applied.

Time period with no motion detected Time interval during which the radio subscriber can stay  at  one place

(min)

Time  period  before  receiving

location data

Period  of  time  after  which  the  subscriber's  coordinates  are  received

again (min)

Time  period  with  no  location  data

received

Period  of  time  during  which  there  are  no  subscriber's  coordinates

(min)

Geofences and Routes Select geofences or routes to follow in the rule.

Speeding

If speeding is registered, the rule is executed.

Note.  The rule triggers  only  when over-speed  occurs  in  the  area  of  the

selected geofence or on  the  selected  route.  Otherwise,  the  rule  is  not

triggered.

Number of subscribers in geofences /

on routes

The number of radio subscribers in selected geofences or on selected

routes.

Select Area (Geofences/ Routes) Select geofences or routes to follow in the rule.
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Attribute Value

Notify constantly

Select this check box to notify the dispatcher about  violation of one of

the criteria every time it happens. If the check box is not  selected,  the

actions  which  follow the  violation  of  the  specified  criteria  will  occur

only once.

Notify about new location

If the subscriber starts moving, and before that the subscriber stopped

for a time period longer than the specified one,  the notification window

will be displayed

If the rule meets selected criteria, the system can perform a series of actions:

1. Actions addressed to the initiator

2. Alerts addressed to the dispatcher

3. Alerts addressed to the radio subscriber

4. Other

If finished, click OK to save the rule, and the created rule appears in the list of rules.

To edit rule settings, select it in the list of rules and click Edit. To remove the rule, select  it  in the list  of rules  and

click Delete.

Initiator Alert

Open the Initiator Alert tab.

Block Radio – if selected, the radio that triggered the rule, will be blocked.
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Lone Worker – if selected and On is clicked, the lone worker profile will be set to the radio that triggered the rule.

If Off is clicked, the lone worker mode of the radio will be deactivated.

Note: To set up the lone worker profile, see Lone Worker Rules in SmartPTT Dispatcher.

Man Down – if selected and On is clicked, the Man Down mode will  be set  to the radio that  triggered the rule.  If

Off is clicked, the Man Down mode of the radio will be deactivated.

Note: Make sure that the radio subscriber unit  has the built-in option board and the Tallysman feature is  enabled

in SmartPTT Radioserver Configurator.

Message – a text message is sent to the subscriber who initiated triggering of the rule.

Dispatcher Alert

Open the Dispatcher Alert tab.

Play Sound – select .wav audio file to play back.

Show on Map – location of the subscriber specified in the rule is shown on the map (with an icon).

Alert – notification with the event description is displayed in the System Notification window. You can define the

title in the Alert Caption field and the description in the Alert Text field.

Note: For rules Stop control and No location data  the alert  text  cannot  be set  – it  is  generated by  the system

automatically.

Set Subscriber Status – the subscriber is assigned the specified status. It is selected from the list of statuses.

Subscriber Alert
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Open the Subscriber Alert tab.

Send Message – a text message is sent to the selected subscribers, talkgroups or categories.

Other

Open the Other tab.

HTTP Request – is used for notification of the third party  server of the changes occurred in SmartPTT system. It

can render the event initiator radio ID and its status. 

The HTTP request includes the following parts:
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Note:  Make sure that  you have  specified  correct  names  for  parameters  1  and  2.  They  must  correspond  to  the

parameters' names expected by the third party server.

Note:  Under "@Status"  SmartPTT system will  send the system  message  corresponding  to  the  newly  assigned

status selected in the Dispatcher Alert tab. Status system messages are set in the Statuses settings.

E-mail – is used for specifying e-mail address where a message should be sent in case the rules  specified earlier

are not fulfilled. To do this, the following fields are to be filled:

Radioserver – server name for e-mail sending. The name of the server is selected from the drop-down list.

E-mail – electronic addresses to send the message.

Message – text of the message.

SMS – if selected, the SMS message is sent to the specified phone number in case the rules specified earlier are

not fulfilled. To do this, the following fields are to be filled:

Radioserver – server name which is  configured for SMS messages sending.  The name of the server is  selected

from the drop-down list.

Phone  Numbers  –  telephone  numbers  to  send  SMS.  The  preferred  number  format  is  International  Number

Format, i.e. <+><country code><mobile code><phone number>.

Message – text of the message.

Note:  See  information  about  SmartPTT  Radioserver  configuration  for  sending  and  receiving  e-mails  and  SMS

messages in SmartPTT Radioserver Configurator Help under Telephone Interconnect and SMS Gateway.

2.5.24  Lone Worker Rules

SmartPTT Dispatcher supports the Lone Worker mode for radio subscribers.
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When a subscriber is set to the Lone Worker mode, SmartPTT automatically tracks the following conditions:

Absence of calls from the subscriber during specified period of time.

Absence of GPS coordinates from the subscriber during specified period of time.

Immobility of the subscriber during specified period of time.

When one of the specified conditions triggers, SmartPTT Dispatcher executes the actions defined by the settings.

To  define  special  rules  or  profiles  for  lone  workers,  expand  the  Settings menu  in  the  Main  Menu  bar  of  the

SmartPTT Dispatcher window and click  Lone  Worker Rules.  At  that,  the window for creation and/or editing the

rules for lone workers opens.

Here you can see the list  of rules  which get  executed if the specified conditions are fulfilled.  SmartPTT supports

multiple rules, so it is possible to create a lone worker rule for each radio subscriber.

To add a new rule,  click  Add.  To make changes in the existing  rule,  select  it  and  click  Edit.  To  delete  a  rule,
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select it from the list and click Delete. 

Note: The default profile cannot be deleted.

At clicking Add or Edit, the Profile Settings window opens.

In the Profile  Settings window you can set  up  rules  for  a  new profile  or  edit  rules  for  the  existing  profile.  The

window contains the following fields and sections:
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Name – name of the profile. It is an obligatory field. 

The General tab contains rule conditions to trigger an alert:

No calls – specifies the period of time for a subscriber to make a voice call. If the subscriber does not make a call

during the specified time period, the corresponding actions are executed.

No location data  received – specifies  the period of time for a subscriber to send  GPS  data.  If  the  subscriber

radio does not send its GPS data during the specified time period, the corresponding actions are executed.

No change in location data – specifies the period of time to check if a subscriber is  moving (deviations in range

of  5  meters  are  ignored).  If  the  subscriber  does  not  move  during  the  specified  time  period,  the  corresponding

actions are executed.

The Subscriber Alert area:

Text  Message  –  when  the  event  specified  in  one  of  the  filters  occurs,  the  text  message  is  sent  to  the  lone

worker.

Audio Message  – when the event  specified in one of  the  filters  occurs,  an  audio  message  is  sent  to  the  lone

worker. To record the message,  click  the Start button.  To stop recording,  click  the Stop button.  To listen to the

recorded message, click Play. To delete the recorded message, click Delete.

Call Alert – when the event described by one of the filters occurs, a Call Alert is sent to the lone worker.

Alert Timer – specifies the time period for a subscriber to make a call, to send GPS coordinates  or to move after

Subscriber Alert took place.

The Actions delay timer defines the time interval after which Actions will be executed after Subscriber Alert. 

If the rule meets selected criteria, the system can execute the following actions:

1. Actions addressed to the initiator

2. Alerts addressed to the dispatcher

3. Alerts addressed to the radio subscriber

4. Other

To save the rule, click OK. At that, the created rule appears in the list of rules.

To edit rule settings, select it in the list of rules and click Edit. To remove  the rule, select it in the list  of rules  and

click Delete.

Initiator Alert
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Open the Initiator Alert tab.

Block Radio – if selected, the radio that triggered the rule, will be blocked.

Lone Worker – if selected and On is clicked, the lone worker profile will be set to the radio that triggered the rule.

If Off is clicked, the lone worker mode of the radio will be deactivated.

Note: To set up the lone worker profile, see Lone Worker Rules in SmartPTT Dispatcher.

Message – a text message is sent to the subscriber who triggered the rule.

Dispatcher Alert

Open the Dispatcher Alert tab.

Play Sound – select .wav audio file to play in SmartPTT Dispatcher.

Show on Map – subscriber specified in the rule is shown on the map (with an icon).

Alert – notification with the event description is displayed in the System Notification window. You can define the

title in the Alert Caption field. and the description in the Alert Text field.  Description of the event  can't  be set,  it

is generated automatically.
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Set Subscriber Status – the subscriber is assigned the specified status. It is selected from the list of statuses.

Subscriber Alert

Open the Subscriber Alert tab.

Send Message – a text message is sent to the selected subscribers, talkgroups or categories.

Other

Open the Other tab.

HTTP Request – is used for notification of the third party  server of the changes occurred in SmartPTT system. It

can render the event initiator radio ID and its status. 

The HTTP request includes the following parts:
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Note:  Make sure that  you have  specified  correct  names  for  parameters  1  and  2.  They  must  correspond  to  the

parameters' names expected by the third party server.

Note:  Under "@Status"  SmartPTT system will  send the system  message  corresponding  to  the  newly  assigned

status selected in the Dispatcher Alert tab. Status system messages are set in the Statuses settings.

E-mail – is used for specifying e-mail address where a message should be sent in case the rules  specified earlier

are not fulfilled. To do this, the following fields are to be filled:

Radioserver – server name for e-mail sending. The name of the server is selected from the drop-down list.

E-mail – electronic addresses to send the message.

Message – text of the message.

SMS – if checked, the SMS message is sent to the specified phone number in case the rules specified earlier are

not fulfilled. To do this, the following fields are to be filled:

Radioserver – server name for SMS messages sending.  The name of the server is  selected from the drop-down

list.

Phone  Numbers  –  telephone  numbers  to  send  SMS.  The  preferred  number  format  is  International  Number

Format, i.e. <+><country code><mobile code><phone number>.

Message – text of the message.

Note:  See  information  about  SmartPTT  Radioserver  configuration  for  sending  and  receiving  e-mails  and  SMS

messages in SmartPTT Radioserver Configurator Help under Telephone Interconnect and SMS Gateway.
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How to assign a Lone Worker Profile to the radio subscriber

To assign the created lone worker profile to a radio subscriber, open the Properties window of the subscriber.

In the opened window select the Lone Worker check box, and in the drop-down list select the created profile.

To remove the profile from the subscriber, clear the Lone Worker check box.

2.5.25  Subscriber Custom Properties

SmartPTT Dispatcher provides the ability  to add custom properties  of a subscriber,  which can be used for giving

additional information about the radio subscriber. Subscriber Custom Properties have the following four types: 

1. Text

2. Numeric

3. Date

4. List
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To  create  custom  properties  expand  the  Settings menu  in  the  Main  Menu  bar  of  the  SmartPTT  Dispatcher

window and click Subscriber Custom Properties. At that, the Subscriber Custom Properties window opens.

The top list contains subscriber custom property groups.

To add the subscriber custom property group, click Add at  the top.  To delete the group,  click  Delete.  Arrows on

the right allow moving groups inside the list.

The bottom list contains the properties of the created groups.

Property Name – custom name of the property which will be displayed in the Properties window.

Type – property type (Text, Numeric, Data or List).

Description – text description added by the user when creating a property.

Active – select the check box, to have the property displayed in the Properties window.

To add a property  into the property  group,  select  the  created  property  group  in  the  top  list  and  then  click  Add
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above the bottom list.

At that, the Subscriber property window opens.

Fill all the fields required. Select the Type and click OK. 

Note: If you want to select List in the Type field, before that you need to create the list.  Otherwise,  the list  will  be

empty.
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To create the list, click the Create/Edit Lists button  . At that, the window opens:

In the top box add list names by clicking Add.

Select the created list and add elements of the list. To do it, go to the bottom box and click Add just above it.
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To view the active custom properties go to the subscriber Properties window, Custom tab.

2.5.26  Custom Consoles

Custom  Console  is  a  tool  that  provides  the  dispatcher  with  custom  workplace.  Custom  consoles  are  visual

panels  containing various elements,  e.g.  radio subscribers,  external dispatchers,  talkgroups,  in short,  everything

the dispatcher need for daily work. Every dispatcher can have his own console with all the radio objects necessary

for his work.
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To  create  and  set  up  a  custom  console,  expand  the  Settings menu  in  the  Main  Menu  bar  of  the  SmartPTT

Dispatcher window and click Custom Consoles. At that, the Custom Consoles window opens.

To add a new console, click Add. At that, the console editor will open.

Name – custom console name which will be displayed in the Tools menu.
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There are 14 types of visual elements available in Custom Consoles.  Description of each element  is  given further

in this article.

To add an element to the custom console, drag and drop the desired element  onto the work  space of the console

designer.  To remove the element  from the work  space,  select  it  and press Delete.  To erase  the  last  change  or

perform the redo function click the Undo or Redo buttons.

You  can  adjust  size,  color  or  location  of  each  element  on  the  custom  console.  You  can  also  add  or  remove

different properties. To do this, select the element and use the Misc or the Properties sections on the right  of the

console designer work  space.  To move the element  up,  down,  left,  or right,  press  the  arrow keys.  To  move  the

element diagonally, press the Up or Down Arrow key and the Left  or Right  Arrow key.  For example,  to move the

element diagonally toward the upper-right corner, press Right Arrow-Up Arrow.

Channel

The  Channel  element  stands  for  a  physical  or  logical  channel.  It  gives  the

following information about the channel:

information about  the current  call  on the channel – the call  state,  the  called

party and the call originator;

default  target  for  outgoing  calls  (it  can  be  either  All  Call  or  any  particular

talkgroup);

muted or unmuted;

the number of missed incoming calls.

To mute the channel,  click  .  Check the Mute Mode settings before  applying

this function.

To open the Action list which can be applied to an element, click .

To display the channel name as Radioserver name – Channel name,  select  the

Radioserver  Name  check  box  in  the  Misc  section.  Otherwise,  only  the

channel name will be displayed.

To view the number of missed incoming calls,  select  the  Missed  Calls check

box in the Properties section.

 shows the  number  of  calls  not  answered  by  the  dispatcher.  The

red figure stands for the number of private calls not answered by  the dispatcher.

The blue one shows the total number of calls  not  answered by  the dispatcher,
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including  private  and  group  calls.  As  soon  as  the  dispatcher  called  back  the

talkgroup or the radio subscriber, the counter is set to zero.

By clicking the button, the window with details appears.

Missed (Dispatcher) – filters only private calls not answered by the dispatcher.

Missed (All) – filters private and group calls not answered by the dispatcher.

All – removes all filters and shows all available talkgroups and radio subscribers

and their call statistics.

Clear All – sets all counters to zero.

Talkgroup

The Talkgroup stands for a talkgroup on the channel.  You can make a call

to the selected talkgroup by clicking on the element.

To open the Action list which can be applied to an element, click .

Also,  the  element  displays  that  the  radio  subscriber  enters  emergency

mode (the Emergency  label),  when  the  Emergency  button  of  the  radio  is

pressed.  Once  the  dispatcher  solves  the  problem  by  clicking   in  the

Emergencies panel,  he clears  the emergency state on the element  of  the

Custom Console.  Once the initiator  clears  the  emergency  on  the  initiator

radio, the emergency is considered over.

You can mute the group call by clicking on the Mute icon. The element  also

shows the state of the current call.

To display the channel name as Radioserver name – Channel name,  select
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the Radioserver Name check box in the Misc section.  Otherwise,  only  the

channel name will be displayed.

Subscriber

The Subscriber element  is  used for making  private  voice  calls  and  shows

the state of the current  call.  By  right-clicking on the element  you can open

the subscriber's  Call  Window  to perform  other  actions  on  the  subscriber.

You can assign the element to different subscribers  from the drop-down list.

To  enable  this  option,  select  the  Allow  Changes  check  box  in  the

Properties section.

To open the Action list which can be applied to an element, click .

Also,  the  element  displays  that  the  radio  subscriber  enters  emergency

mode (the Emergency  label),  when  the  Emergency  button  of  the  radio  is

pressed.  Once  the  dispatcher  solves  the  problem  by  clicking   in  the

Emergencies panel,  he clears  the emergency state on the element  of  the

Custom Console.  Once the initiator  clears  the  emergency  on  the  initiator

radio, the emergency is considered over.

 – the icon on the subscriber element shows that  the dispatcher did not

answer  to  the  subscriber  call.  The  figure  next  to  it  shows  the  number  of

missed calls.

Telephone Subscriber

The Telephone  Subscriber element  is  used for making calls  to telephone

subscribers.

Note: For proper operation of the element select Allow Calls to Telephone

Subscribers  in  the  General  Settings  tab  of  the  Telephone  Settings

window.

You  can  assign  the  element  to  different  telephone  subscribers  from  the

drop-down list. To enable this option, select the Allow  Changes check box

in the Properties section.
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Note:  To  set  the  list  of  telephone  subscribers,  go  to  the  Telephone

Subscribers window.

Dispatcher

The  Dispatcher  element  is  used  for  making  connection  to  other

dispatchers. Clicking on the element opens the dispatcher's Call Window.

Note:  For proper operation of the element  make sure that  the  operator  has

the  permission  Connect  with  external  dispatchers  (Settings  >

Operators)

You can assign the element to different dispatchers  from the drop-down list.

To  enable  this  option,  select  the  Allow  Changes  check  box  in  the

Properties section.

Note: The list of dispatchers  contains  dispatchers  added in the Dispatchers

window.

Channel Selector

The Channel  Selector  element  allows  the  dispatcher  to  switch  from  one

channel of the control station to another.

Note:  The functionality  requires  the  control  station  to  be  connected  to  the

PC  and  its  channels  to  be  set  up  via  MOTOTRBO  CPS  and  SmartPTT

Radioserver Configurator.

Channel setting in SmartPTT Radioserver Configurator is  carried out  on  the

Channels  tab  of  the  control  station.  Channels  listed  on  this  tab  must

match  the  channels  set  in  MOTOTRBO  CPS  (channel  number,  zone

number).

To  configure  this  functionality  in  SmartPTT  Dispatcher,  add  the  Channel

Selector element  into the console designer work  space.  One element  can

be  assigned  to  one  channel.  To  allow  switching  between  channels,  you

should add the required number of elements.
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Outgoing Telemetry

The Outgoing Telemetry element is used for sending telemetry commands

to the radio subscriber.  You  can  assign  only  one  telemetry  command  per

element. Before assigning the telemetry  command to the element,  add it  to

the  telemetry  list  of  commands  and  to  the  radio  subscriber.  Apart  from

sending commands, you can also check the current  status  and the time of

the last status update.

Incoming Telemetry

The Incoming Telemetry element is used for receiving the current status of

the selected pin. You can also see the time of the last status update.

Voice Notification

The Voice  Notifications element  starts  or stops the  voice  notification  and

displays  how many times the voice notification is  reproduced.  To  configure

voice  notifications  see  the  Voice  Notification  section  in  SmartPTT

Radioserver Configurator.

Note:  To  monitor  the  current  status  of  the  voice  notification  playing,  open

the Voice Notifications window (Service > Voice Notifications).

To  display  the  element  name  as  Radioserver  name  –  Voice  Notification

name,  select  the  Radioserver  Name  check  box  in  the  Misc  section.

Otherwise, only the voice notification name will be displayed.

Broadcast Call

The Broadcast Call  element  is  used for making group  calls  or  an  All  Call

within all  the channels  of  the  dispatch  console  simultaneously.  Select  the

required talkgroup or All Call ID in the Talkgroup ID field of the Properties

section. When such a call  is  initiated,  SmartPTT Dispatcher tries  to call  all

of the subscribers with the given identifier.
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Panel

The Panel element is used for uniting several elements. The panel can have

its  own  color,  size  and  placement.  All  inside  elements  of  one  panel  are

moved together with the panel.

Incoming Events

The  Incoming  Events informs  about  incoming  messages,  call  alerts  and

missed  private  calls  to  SmartPTT  Dispatcher  from  radio  subscribers.

Double-click the record in the panel to open the subscriber's Call Window.

TMS

The  TMS  element  is  used  for  sending  short  text  messages  to  all

subscribers  or talkgroups situated in one panel with the TMS  element.  To

do this, just  enter the text  of the message or select  a template,  and send

it.  If  the  TMS  element  is  placed  outside  a  panel,  it  will  send  private

messages. To do this, just select the radio subscriber, enter the text  of the

message and send the message.

PTT

The PTT element  is  used for a multiple-user call.  If it  is  located  inside  the

panel, clicking the PTT element makes a call  to all  the subscribers  located

within  this  panel.  If  it  is  located  outside  the  panel,  the  PTT  element

becomes disabled.

When in work, color of the elements with the assigned subscribers differs depending on the status.

Element Description

Gray – the subscriber is offline or outside the network coverage
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Gray blue – the subscriber is online

Light yellow – the oprerator is trying to make an outgoing call

Yellow – outgoing call from SmartPTT Dispatcher to radio subscriber

Green – incoming call to SmartPTT Dispatcher or the radio is being monitored

Blue – none of the  parties  transmit  or  receive  voice.  The  subscriber  can  answer  the  call  by

pressing the PTT button within hang time. After the hang time expires,  the subscriber initiates

a new call by pressing the PTT button. The calling subscriber is  the subscriber linked with the

PTT button by default.

Blue frame – the subscriber is selected

You can open the created custom consoles  from the Tools menu.  SmartPTT Dispatcher allows opening multiple

custom consoles simultaneously.

2.6  Service
The Service menu allows you to carry out secondary functions, namely:

Radio Check allows you to send the radio check command to radio subscribers.

Voice Notifications allows you to play voice notifications.

Deferred Actions allows you to view and edit deferred actions.

Received Files allows you to view files received by the radioserver via SmartPTT File Transfer.

System Information allows you to check event  statistics  registered on the radioserver or in the dispatcher

console and other information on the system.

Export Radio Subscribers allows you to save the list of registered radio subscribers in XML or XLS formats.

Import Radio Subscribers allows you to import previously exported list of radio subscribers.

Upload to KML allows you to export current geographical position of radio subscribers in KML format.

Import Connect Plus Logs allows you to import data from the Connect Plus network.

Save Dispatcher Settings allows you to save current  settings of the  dispatcher  console  and  database  to
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restore them in the future.

Restore  Dispatcher  Settings  allows  you  to  restore  saved  settings  of  the  dispatcher  console  and  the

database.

2.6.1  Radio Check

The  Radio  Check  function  can  be  executed  on  the  selected  control  stations  available  to  the  dispatcher.  The

result  of the Radio Check is  displayed in the  subscriber  Call  Window.  It  can  be:  "Subscriber  is  available"  or

"Subscriber is unavailable".

To do Radio Check,  expand the Service  menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Radio Check. At that, the Radio Check window opens.

Specify  the  IP  of  the  subscriber  radio.  Select  control  stations  which  should  be  used  to  check  the  subscriber

availability and click Send.
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Alternatively, Radio Check can be done from the Call Window or the Action List.

In the Action List:

2.6.2  Voice Notifications

The main purpose of the voice notification functionality is to warn talkgroups about the fire or other emergency and

to manage evacuation. However, in normal mode voice notification can be used for usual voice announcements.

Warning! You can create  voice  notifications only in SmartPTT Radioserver Configurator (Radioserver >

Add-on  Modules  >  Voice  Notifications).  You  can  run  the  created  voice  notifications  from  SmartPTT

Dispatcher.
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To  play  a  voice  notification  in  selected  systems,  expand  the  Service  menu  in  the  Main  Menu  bar  and  click

Voice Notifications. At that, the Voice Notifications window will open.

Radioserver  –  select  the  radioserver  from  the  list.  The  list  contains  only  active  and  running  radioservers,

registered in the dispatch console .

Voice  Notifications  –  select  a  voice  notification  from  the  list  of  items  created  in  SmartPTT  Radioserver

Configurator.

To play  the voice notification,  select  the radioserver and the voice  notification,  and  click  Start.  To  stop  playing,

click Stop.

Note: To play a voice notification, you can use the Voice Notification element, added to the custom console.
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Note: When the voice notification is  stopped,  it  does not  stop playing immediately,  but  only  after it  played on all

selected channels within a single repetition.

Notifications Left – specifies the number of remaining voice notification repetitions.

Channels – contains  a list  of channels  specified for the selected  voice  notification.  Here  you  can  also  see  the

current status of the voice notification playing, and the number of completed playbacks. The channel is  highlighted

green, when voice notification playing was successfully  completed on this  channel.  When voice notification can't

be played on the channel (for example,  hardware or virtual device is  not  available at  the moment),  the channel is

highlighted red. While voice notification is played on the channel, the channel is highlighted yellow.

2.6.3  Deferred Actions

SmartPTT Dispatcher allows creating deferred actions.  In this  version these are audio and text  messages,  which

are  to  be  delivered  to  a  radio  subscriber  even  if  the  radio  subscriber  is  offline  at  the  moment  of  message

transmission.  As soon as the radio subscriber becomes available,  the message is  sent  to the addressee.  If  the

radio subscriber is online at the moment of message transmission, the message is delivered at once.

Note:  Dispatcher  can  create,  edit  or  view deferred  actions  only  if  the  Create  Deferred  Actions permission  is

selected. For more information see the Operators section.
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To create a deferred action open the Action List or the Call  Window  and select  Create  Deferred Action.  The

radio subscriber can be either online or offline.
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Or in the Actions List

At that, the following window opens.

Radioserver  –  lists  all  the  available  radioservers,  where  a  deferred  action  can  be  created.  The  drop-down  list

contains  radioservers  with the status  “Active” only  (see Radioservers in the Settings menu  in  the  Main  Menu

bar).
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Send Audio Message  –  allows  creating  audio  messages.  To  record  a  message  make  sure  the  Send  Audio

Message check box is selected. Then click Record. After you have recorded the message, click Stop. 

To replay the recording, click Play. To stop the playback, click Stop.

Note: The buttons Record and Play are unavailable if Send Audio Message is not selected.

Send Text Message – allows creating text messages. To enable the input field,  select  the Send Text Message

check box. 

Save – saves the newly created audio or text message or updates the existing message.

Cancel – closes the window. At that, unsaved changes will be lost. 

View Deferred Actions – opens the list of deferred actions.

Deferred Actions – allows checking the list  of audio and text  messages which are to be sent.  As soon  as  the

message is sent to the radio subscriber, it is removed from the list.

Current Radioserver – allows selecting the radioserver whose list  of deferred actions is  to be viewed.  The drop-

down list contains only registered radioservers (see Settings >  Radioservers).  If the radioserver is  registered but

not running, it won’t be on the drop-down list.

Load Action List – loads the list of unsent deferred messages per selected radioserver.

Delete – deletes selected message.

Cancel – closes the Deferred Actions window.

Edit – allows making changes in the existing,  that  is  unsent,  message.  To edit  a message,  select  the message

you need and click Edit.

After changes have been made, click Save.
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Note: You can also get to the edit mode by double-clicking on the message.

2.6.4  Received Files

SmartPTT Dispatcher provides the ability  to view files  sent  from radio stations with the help of a  free  application

SmartPTT File Transfer.

To  view  the  files  received  from  radio  stations,  expand  the  Service  menu  in  the  Main  Menu  bar  and  click

Received Files. At that, the following window opens.

Current Radioserver – allows selecting files from one available radioserver or all available radioservers.

Retrieve File List – loads received files for the selected radioserver.

Download – opens the window for saving the selected file.  You can also open this  window by double-clicking on

the selected file.

Delete – deletes the selected file from the list.

Close – closes the Received Files window.

2.6.5  System Information

In the System Information window the dispatcher can see:

1. The total number of events taking place either on the dispatcher console or on the radioserver.

2. Database file size and free space.

3. Size of the record folder.

To  open  the  System  Information  window,  expand  the  Service  menu  in  the  Main  Menu  bar  of  SmartPTT

Dispatcher.
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Click View System Information. At that, the following window opens.

2.6.6  Export Radio Subscribers

SmartPTT Dispatcher  provides  the  ability  to  export  subscriber  list  from  one  SmartPTT Dispatcher  and  then  to

import it into another. Only registered radio subscribers can be exported.

To export the list of radio subscribers, expand the Service  menu in the Main Menu bar and click  Export Radio

Subscribers. At that, the following window opens.
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In the Format area select the format in which you want  to export  the subscriber list.  To select  the file for export,

click  . Supported file formats: XLS and XML. Then click OK. At that, the file with the exported data will open.

The example of the exported file in XLS format:

The example of the exported file in XML format:

ID — automatically generated ID of the radio subscriber.

IP Address – radio subscriber IP address.

Network ID – network ID which is specified in MOTOTRBO Customer Programming Software (see parameter CAI

Network).

Radio ID – unique identifier of the radio unit.

Name – radio subscriber name specified in the subscriber's Properties window in SmartPTT Dispatcher. 

GPS – shows whether the radio supports GPS.

MDC ID – radio ID in the analog data channel.

Icon – path to the icon selected per subscriber. If a radio subscriber has a default  icon,  the corresponding field in

the export file is empty.

Show on map – shows whether the subscriber's location is visible on the map.
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Lone Worker – shows whether the subscriber is in the "lone worker" mode.

Select 5 ID – shows the 5 Tone identifier of the subscriber.

Indoor Support – shows whether the subscriber is  visible on the building plan by  the dispatcher request  or after

the predefined time period.

Indoor Request – shows whether the option Update Interval for Indoor Tracking is selected.

Indoor Update Interval – the time interval in seconds for location data update from special beacons,  which are

installed in buildings.

GPS  update  with  time  interval  –  shows  whether  the  GPS  Update  location  with  time  interval  option  is

selected.

Time  Interval  – shows the time interval in seconds after which the GPS coordinate request  will  be  sent  to  the

radio subscriber.

GPS update with distance interval – shows whether the GPS Update location with distance  interval  option

is selected.

Distance Interval – shows the distance interval in meters  or feet  after which the GPS coordinate request  will  be

sent to the radio subscriber.

GPS on GPIO pin status change  – shows if the  GPS  coordinate  request  will  be  sent  to  the  radio  subscriber

when the status of telemetry contacts changed.

GPS on emergency – shows if the GPS coordinate request  will  be sent  to the radio subscriber when the radio

subscriber sends an emergency alarm.

Note: The following properties  of the subscriber in exported files  may have two possible values:  "True" or "False"

for files  in  XLS  format;  "Yes"  or  "No"  for  XML  format:  GPS,  Show  on  map,  Lone  Worker,  Indoor  Support,

Indoor Request,  GPS update  with time  interval,  GPS update  with  distance  interval,  GPS  on  GPIO  pin

status change, GPS on emergency.

2.6.7  Import Radio Subscribers

SmartPTT Dispatcher  provides  the  ability  to  import  subscribers  (in  XLS  and  XML  format)  from  one  SmartPTT

Dispatcher to another. 
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To import the list of radio subscribers, expand the Service  menu in the Main Menu bar and click  Import Radio

Subscribers. At that, the following window opens.

In the Format area select the format in which you want  to import  the subscriber list.  To select  the file for import,

click  . Then select the import options.

Add New  Records – when the check box is  selected,  at  importing,  new subscribers  (not  existing  in  SmartPTT

Dispatcher) will be added to the list of subscribers.

Update Existing Records – when the check box is selected, at importing, the existing data on the subscribers  in

SmartPTT Dispatcher is replaced with the data from the imported file.

Note:  It  is  possible to select  both import  options at  a time.  At  that,  new records will  be  added  and  the  existing

records will be updated.

Click OK to launch import process.

Click Cancel to close the window.

Note: To apply changes after importing, it is important to restart SmartPTT Dispatcher.

The example of the imported file in XLS format:
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The example of the imported file in XML format:

ID – automatically generated ID of the radio subscriber.

IP Address – radio subscriber IP address.

Network ID – network ID which is specified in MOTOTRBO CPS (see parameter CAI Network).

Radio ID – unique identifier of the radio unit.

Name – radio subscriber name added in the subscriber's Properties window in SmartPTT Dispatcher. 

GPS – shows whether the radio supports GPS.

MDC ID – radio ID in the analog data channel.

Icon – path to the icon selected per subscriber. If a radio subscriber has a default  icon,  the corresponding field is

empty in the export file.

Show on map – shows whether the subscriber's location is visible on the map.

Lone Worker – shows whether the subscriber is in the "lone worker" mode.

Select 5 ID – shows the 5 Tone identifier of the subscriber.

Indoor Support – shows whether the subscriber is  visible on the building plan by  the dispatcher request  or after

the predefined time period.

Indoor Request – shows whether the option Update Interval for Indoor Tracking is selected.

Indoor Update Interval – the time interval in seconds for location data update from special beacons,  which are

installed in buildings.

GPS  update  with  time  interval  –  shows  whether  the  GPS  Update  location  with  time  interval  option  is

selected.

Time  Interval  – shows the time interval in seconds after which the GPS coordinate request  will  be  sent  to  the

radio subscriber.

GPS update with distance interval – shows whether the GPS Update location with distance  interval  option

is selected.

Distance Interval – shows the distance interval in meters  or feet  after which the GPS coordinate request  will  be

sent to the radio subscriber.

GPS on GPIO pin status change  – shows if the  GPS  coordinate  request  will  be  sent  to  the  radio  subscriber

when the status of telemetry contacts changed.

GPS on emergency – shows if the GPS coordinate request  will  be sent  to the radio subscriber when the radio
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subscriber sends an emergency alarm.

Note: The following properties  of the subscriber in imported files  may have two possible values:  "True" or "False"

for files  in  XLS  format;  "Yes"  or  "No"  for  XML  format:  GPS,  Show  on  map,  Lone  Worker,  Indoor  Support,

Indoor Request,  GPS update  with time  interval,  GPS update  with  distance  interval,  GPS  on  GPIO  pin

status change, GPS on emergency.

2.6.8  Upload to KML

SmartPTT Dispatcher supports export of the current subscriber coordinates  in KML format.  This  format  is  used in

Google Maps/Google Earth systems.

To  save  subscriber  coordinates  in  KML  file  format,  expand  the  Service  menu  in  the  Main  Menu  bar  of  the

SmartPTT Dispatcher window and click Upload to KML. At that, the following window opens.

The interface of the window depends on where you selected to store the KML file – to a local folder or to FTP.

Click Local File to keep the uploaded KML file locally.

KML File – specify the destination folder and the name of the KML file with the subscriber coordinates.

You can also set  up automatic  upload.  Simply,  select  the Auto upload time  interval  check box and enter the

time interval.

When everything is ready click Export to launch the upload process.
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You can also store the uploaded file on FTP. To do that, click FTP at the top of the window.

KML File  – specifies  the destination folder and the name of the KML file with the subscriber coordinates  on the

FTP server.

Fill in the Login and Password fields if the FTP server requires authentication.

To exit and save the settings, click Close.

To exit without saving the settings, press ESC.

How to display subscribers' coordinates

To view subscriber coordinates from the FTP file:

1. Open the website http://www.google.com.

2. Click on Maps (the page http://maps.google.com/maps?hl=en&tab=wl is displayed).

3. Enter  a  direct  HTTP  link  to  the  file  located  on  the  FTP  server  (for  example,  http://myserver/smartptt/

Radios_smartptt.kml) in the Google maps field and click Search Maps.

To view subscriber coordinates from the local file in Google Earth:

1. Start Google Earth.

2. Select Open (from the File/Open menu or press CTRL+O).

3. Specify the path to the local file with the subscriber coordinates in KML format and click Open.

http://www.google.com/
http://maps.google.com/maps?hl=en&tab=wl
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How to configure subscribers' coordinates display with automatic update in
Google Earth

1. Start Google Earth.

2. Select the menu command Add/Network Link.

3. In the Name field specify the place mark name to be displayed in Google Earth.

4. To view the file from the FTP server, enter a direct HTTP link  to the file located on the FTP server (for example,

http://myserver/smartptt/Radios_smartptt.kml).

To view the file from the local disk,  click  Browse,  specify  the path to the file with subscriber coordinates  in KML

format and click Open.

5. Click the Refresh tab, select the Periodically option and set an update interval.

6. Click ОК: SmartPTT subscribers should now be displayed in Google Earth.

7. To open the added KML file automatically  the next  time Google Earth is  run,  you  should  save  the  temporary

place mark  "Subscribers  (SmartPTT)"  to My Places list.  To  do  this  please  select  the  menu  command  File/

Save/Save to My Places or press CTRL+SHIFT+S.

2.6.9  Import Connect Plus Logs

SmartPTT Dispatcher  allows  importing  Connect  Plus Logs  to  the  Event  Log.  This  is  useful  for  dispatchers

joining a new Connect  Plus  radio network  to get  data on the events  in this  network.  The  data  is  taken  from  the

XRC Controller.

To import  Connect Plus Logs,  expand the Service  menu  in  the  Main  Menu  bar  of  the  SmartPTT Dispatcher

window and click Import Connect Plus Logs. The Import Connect Plus Logs window opens.

Logs File – specifies the path to the folder where Connect Plus log file is stored. 
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CAI – CAI-Network identifier. It’s recommended to use the default value 12. It is set in the range from 1 to 126.

CAI for Groups – the identifier of the group's CAI-Network. It’s recommended to use the default value 225. It is set

in the range from 225 to 239.

If you click Import, Connect Plus data import to the Event Log will be started.

All Files – displays the total download progress.

When Connect Plus Log file is imported, you will see the following notification window.

2.6.10  Save Dispatcher Settings

Starting from version 8.3 you can save and restore not only the event  log database,  but  also the dispatch console

settings.  These  includes:  opened  panels,  subscriber  list,  the  application  interface  language  and  many  other

things.
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To save current settings or database, open the Service menu and select Save Dispatcher Settings.  At  that,  the

following window opens up:

Objects – define what you want to save. You can select both, if needed. 

Archive File – specify the path to the folder where you need the archive to be saved.

To save the selected objects, click Save. To quit the window without saving, click Cancel.

To restore the saved settings and database, see Restore Dispatcher Settings.

2.6.11  Restore Dispatcher Settings

To restore the saved dispatch console settings or database (see how to save the dispatch console settings here),

open the Service menu and select Restore Dispatcher Settings. At that, the following window will open:

Archive File – specify the path to the archive folder.
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Objects – define what you want to restore. You can select more than one option.

Override Dispatcher GUID – if selected,  SmartPTT Dispatcher globally  unique ID is  replaced with the imported

value.  After  importing,  there  are  two  dispatch  consoles  with  identical  GUID’s.  If  check  box  is  not  selected,

SmartPTT Dispatcher  globally  unique  ID  is  left  unchanged.  After  importing,  there  are  two  servers  with  same

configuration settings, but different globally unique GUID’s.

To restore the selected objects, click Restore. To quit  the window, click  Cancel.  To apply  the restored settings,

restart the application.

2.7  Reports
The Reports menu presents all the reports available in the system:

Report Wizard allows you to build a report on the basis of the Event log.

Radio  Activity  Report  allows  you  to  view the  number  of  all  calls  and  group  calls  during  a  defined  time
period.

Subscriber  Location  Report  is  a  special  report  that  displays  GPS  coordinates  of  the  selected  radio
subscribers.

Online Subscribers report gives you a list of registered and non-registered subscribers online.

Lone  Workers  report  gives  you  the  information  about  events  that  occur  when  the  radio  is  in  the  Lone
Worker mode.

2.7.1  Report Wizard

Report  Wizard  functionality  provides  flexible  report  creation  based  on  the  information  stored  in  the  SmartPTT

Dispatcher  Event  Log.  Using  the  Report  Wizard  it  is  possible  to  select  the  necessary  fields  for  the  report,

specify grouping and sorting fields, specify filtering criteria. Reports generated by the Report Wizard are exported

to Microsoft Excel.

To use the Report Wizard, expand the Reports menu in the Main Menu bar of the SmartPTT Dispatcher window

and click Report Wizard. At that, the Report Wizard window opens.

1. In the window that opened select the data source of the future report.  You can select  between the database of

the dispatch console and the database of the radioserver. To be able to select the radioserver's database,  make

sure that the radioserver is up and running.

2. Select fields which you want to include in the report and click Next.
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3. Define the structure of the report – its grouping and sorting. 

Note: If both fields are not specified, the report will be grouped and sorted by default.

When ready, click Next.

4. Filter the report by values. Click Next to continue.
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5. Specify  the file name of the report.  To complete the process,  click  Finish.  The report  can be saved in HTML,

MHT, XLS, XLSX, CSV, and TXT formats.
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2.7.2  Radio Activity Report

Radio Activity Report gives information about quantity and duration of All  Calls  and Group Calls  with a breakdown

into hours or days.
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To create the report,  expand the Reports menu and select  Radio Activity Report.  The Radio  Activity  Report

window opens.

Period – defines the time frame for the report data.

Source  – defines the source,  which database will  be used  for  the  report.  If  Dispatcher  is  selected,  the  data  is

taken from the local database. Apart from Dispatcher,  any available radioserver can be chosen as a data source.

In that case all data is taken from the database of the chosen radioserver.

Channel – allows to build a report for a particular channel of for all control stations.

Group by – defines the level of detail,  whether you want  to see the report  information divided into days,  hours  or

minutes.
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The report can be saved in PDF, HTML, MHT, RTF, XLS, XLSX, CSV, TXT, Image or XPS formats.
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2.7.3  Subscriber Location Report

SmartPTT Dispatcher allows creating a report  on subscriber's  locations.  The report  can be saved in PDF, HTML,

MHT, RTF, XLS, XLSX, CSV, TXT, Image or XPS formats.

To create the report, expand the Reports menu in the Main Menu and click  Subscriber Locations.  At  that,  the

Subscriber Locations window will open.

Period – defines the time frame of the report.

Source  – defines the source,  whose database will  be used for the report.  If  Dispatcher  is  selected,  the  data  is

taken from the local database. Apart from Dispatcher,  any available radioserver can be chosen as a data source.

In  that  case  the  data  is  taken  from  the  database  of  the  chosen  radioserver.  To  build  a  report  based  on  the

radioserver database, make sure that Event Log is enabled and connected in SmartPTT Radioserver Configurator.

Subscriber – defines subscriber for whom the report is  to be generated.  The list  of subscribers  is  taken from the

current  database.  When  All  is  selected,  the  report  will  be  generated  for  all  subscribers  which  have  GPS

coordinates in the database.

Group by subscribers – groups data in the report by radio subscribers.

UTC Time  – if selected,  the report  time will  be converted to UTC format.  If UTC Time  is  not  selected,  the local

time of the radioserver PC will be shown in the Subscriber Locations Report.

RSSI – if selected, the signal strength of the received signal (RSSI) is displayed in the report.
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Address – allows displaying address information based on the received coordinates.  The addresses are received

from one of the two services Google Maps or OpenStreetMap.  The service is  selected in Settings >  Positioning

Systems > Address Data Provider. If the Address check box is  not  selected,  there will  be a link  Find on Map

instead of the address. You can use the link to see the address.

Route – defines the route on the basis of which the Subscriber Locations Report is to be generated.

Only Key Point – displays only the key points of the route in the report.

Click OK to create the report.

In  order  to  set  up  the  format  of  Latitude,  Longitude,  Speed  and  Precision  columns  of  the  Subscriber

Location Report, see Positioning Systems, the GPS tab, in SmartPTT Dispatcher.

Note:  The  Universal  Transverse  Mercator  Coordinate  System  format  is  not  applicable  to  this  report.  If  it  is
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selected, Latitude and Longitude are displayed in Decimal degrees format.

2.7.4  Online Subscribers

SmartPTT allows exporting online subscribers  (registered and not  registered) in no time by means of the Online

Subscribers report.

To create the report,  expand the Reports menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Online Subscribers. At that, the following window opens.

All – select this radio button to include all registered and not registered online subscribers in the report.

From ... to ... – select this radio button to limit the number of subscribers in the report.

Click OK. At that, the report opens. The report can be exported to PDF, HTML, MHT, RTF, XLS, XLSX, CSV, TXT,

Image or XPS formats.  The report  contains  three columns:  Radio ID,  Channel  Type  and Name.  The  Channel

Type column can have three values: MOTOTRBO, Analog, Select 5.
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2.7.5  Monitoring Report

Monitoring Report is a report based on the data collected during monitoring and filtered by  different  criteria.  The

report gives such information as repeater ID,  ID's  of the calling and receiving parties,  duration of the event  and its

type, RSSI and many other.

Note: Before building a report, make sure the radioserver is up and running.

To create the report, expand the Reports menu in the Main Menu bar and under Monitoring select  Report.  At

that, the following window appears.

Period – defines the time frame of the report.

Radioserver – defines the radioserver, whose database you want to use as a data source.

Subscriber – selects  the subscriber for whom the report  is  to be generated.  If you select  All,  the report  will  be

generated for all registered subscribers.

UTC Time  –  if  UTC Time  is  selected,  the  report  time  will  be  converted  to  UTC  format.  If  UTC  Time  is  not

selected, the local time of the radioserver PC will be shown in the report.

Sort By – you can select the column by which you want  to sort  the report  data:  network,  repeater,  slot,  protocol,

sender, receiver, duration, RSSI.

2.7.6  Monitoring Log

Monitoring Log shows information about available devices in the system (e.g.,  repeaters,  routers,  uninterruptible

power supplies) and alarms registered on these devices.
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Note: Before building a report, make sure the radioserver is up and running.

To create the report, expand the Reports menu in the Main Menu bar and under Monitoring select Log.  At  that,

the following window opens.

Period – defines the time frame of the report.

Radioserver – defines the radioserver whose database you want to use as a data source.

After clicking OK, the report opens automatically:
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2.7.7  Monitoring Analytics

Monitoring Analytics is a graphical representation of the data received during a monthly monitoring process.

To build a report,  expand the Reports menu in the Main Menu bar,  and under Monitoring select  Analytics.  At

that, the following window opens.

Start  Date  –  specify  the  start  date  of  the  report.  This  is  a  monthly  report,  so  the  end  date  is  calculated

automatically.

Radioserver – select  the available radioserver whose database will  be  used  as  a  data  source.  Make  sure  that

Monitoring is enabled and the monitoring database is connected in SmartPTT Radioserver Configurator.
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Network – select  the  radio  system  for  which  you  want  to  build  a  report.  The  drop-down  list  contains  all  radio

systems which have been ever used. Network ID’s are used for old networks, and names—for existing ones.

Site  – select  a site.  This  is  used for Linked Capacity  Plus  networks.  You can also build a report  for all  existing

sites, or select no sites at all.

Repeater – select the particular repeater. You can also build a report for all repeaters.

Subscriber – select  the subscriber for whom the report  is  to be built.  You can build a report  on  all  subscribers

from the drop-down list.

Report sample:
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Export – allows you to save the report in HTML format for further use.

2.7.8  System Usage

The System Usage report provides information on the system load, operation time of the system, downtimes,  and

other information.  To build the report,  expand the Reports menu  in  the  Main  Menu  bar  and  under  Monitoring

select System Usage. At that, the following window opens.
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Period – defines the time frame of the report.

Radioserver – select  the available radioserver whose database will  be used as  a data source.  To build a  report

you need to enable Monitoring in SmartPTT Radioserver Configurator and create a new monitoring database,  or

connect to the existing one.
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System – defines the radio system for which you want  to build a report.  In the drop-down list  you can  find  both

existing and removed radio systems.  Network  IDs are used for outdated radio systems,  and names—for existing

ones.

After setting the parameters, click OK and the report will open in a new window.

2.7.9  Lone Workers

The Lone  Workers report  provides information about  the radio subscriber events  when  the  radio  is  in  the  "lone

worker" mode, for example, registration on the network, the incoming or outgoing calls and messages.
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To create the report  expand the Reports menu in the Main Menu bar of the  SmartPTT Dispatcher  window and

select Lone Workers. The Lone Workers window opens.

Period – defines the time frame for the report data.

Subscriber – defines the subscriber for whom the report  is  to be generated.  The list  of subscribers  is  taken from

the connected database.

Sort By – defines the sorting field for the report  events.  Sorting parameters:  direction,  event  type,  date and time,

additional information, operator, control station, subscriber, group, status, duration, repeater IP address, receiver.

The report can be saved in PDF, HTML, MHT, RTF, XLS, XLSX, CSV, TXT, Image or XPS formats.
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2.8  User Interface Layout

The UI Layout Settings button   in the Main Menu bar contains two features:

Locking UI Layout (for more information see Lock UI Layout)

Customization  of  the  UI  layout.  When  working  with  SmartPTT Dispatcher  the  operator  opens  many  different

windows.  Some of them are  used  very  often.  Usually,  at  every  launch  of  the  application  all  the  windows  are

closed and the operator needs to spend considerable time to configure the main area. This  is  quite inconvenient

and time-consuming. In order to avoid this, the operator can save his/her windows configuration at the end of the

work day, prior to the application shutdown, and restore the configuration the next day.  There can be more than

one  window  configuration  and  the  operator  can  switch  between  them.  To  save  the  current  layout  of  the

application user interface for future use, select Set UI Layout,  and then click  Add.  Enter the name of the user

interface layout.  To restore the selected user interface layout,  click  Apply.  To delete the saved  user  interface

layout, click Delete.

 

2.8.1  Lock UI Layout

Locking user interface layout feature is  available only  for Administrator account  and allows blocking any dispatch

console layout  changes  for  operators.  It  allows  administrator  to  do  specific  console  customization  and  prevent

ordinary dispatchers from opening and closing windows and panels.

In order to fix panel positioning, click  and then select Lock UI Layout.

When this mode is enabled, the dispatcher can't do the following actions:

Opening and closing panels. Automatic pop-up panels, such as  Notifications and System messages,  do

not open either.

Changing panel location (see Changing Layout).

Switching user interface layouts.

Changing the size of the opened panels.

Changing the content of the Radio Fleet panel.

Note: If the Event Log is opened when the user interface layout is locked,  all  the features  designed for the Event

Log management are available to the dispatcher.
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2.9  Bridging
SmartPTT Bridging  service  allows  joining  multiple  network  systems  into  a  single  radio  network.  The  bridging

service is  implemented by  SmartPTT Radioserver  and  provides  intelligent  means  of  patching  for  voice  and  data

streams between various network systems.

In SmartPTT Plus the bridging service allows you to :

join various radio networks;

bridge two or more radioservers to cover distributed regions;

bridge selected voice and data;

bridge private and group calls dynamically;

break the barrier of 15 repeaters per IP Site Connect;

have calls bridged with only a short voice delay (from 60 ms), when joining IP Site Connect systems.

Radio network configurations supporting bridging:

1. NAI networks

2. Connect  Plus  networks.  The  current  version  of  SmartPTT  Dispatcher  supports  only  talkgroup  call
exchange between Connect  Plus  networks  and analog control stations,  digital control stations (analog or
digital  conventional  channels),  NAI  networks  (the  Voice  connection  type)  or  Connect  Plus  networks.
Bridging  of  Connect  Plus  networks  with  other  network  types  is  not  supported  yet.  Any  other  data
exchange between Connect Plus and other networks is not supported yet.

3. SIP/RTP interfaces

4. External SmartPTT radioservers

5. Digital conventional channels. Private calls or data can't be bridged in networks based on control stations.

6. Analog conventional channels. Private calls can't be bridged in networks based on control stations.

How to Configure Bridging in SmartPTT Dispatcher Console

You can configure bridging settings in the call bridging table in SmartPTT Dispatcher. It was designed to make the

process  of  bridging  configuration  simple  and  easy.  The  main  idea  of  the  configuration  process  is  to  manage

bridging  with  the  help  of  the  so-called  "Profiles"  and  "Route  Groups".  The  profiles  contain  information  on  the

bridging rules, which are specified in route groups and further in routes. So, there are three levels:

1. Routes

2. Route Groups

3. Profiles
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Route – basic unit of the bridging process and an integral part  of the route group,  that  is  a route cannot  be used

separately.  It  is  in  the  route  where  you  define  the  source  and  the  destination  networks,  and  other  main

characteristics of the route.

Route Group – group which unites several routes. It was designed to provide a neat look to profiles. Route groups

can be easily activated and deactivated, which will either make routes inside route groups usable or not usable.

Profile  – saved template of route groups.  Profiles  can be created for various business fields,  for  example,  there

can be profiles for general purposes, for carrying out engineering work or for emergency situations, etc.

You can configure bridging settings individually  for each radioserver from SmartPTT Dispatcher.  To open the  call

bridging table, open the Action List by clicking the button  next to the radioserver and select  Configure  Call

Bridging Table.

At that, the Bridging Configuration window opens.

This  is  the  main  window from  where  you  can  create  routes,  route  groups  and  add  them  to  new  profiles.  The
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window also  informs  about  the  name  of  the  current  radioserver,  its  current  profile,  the  list  of  available  routes

organized in groups.

Show Details – displays details of the route groups. You can also check the details of a particular route group by

clicking a plus sign next to the route group name.

Hide Details – displays only route group names and the Active check box.

By default, the bridging table displays only active route groups, which belong to the selected profile.  To display  all

route groups, select the All option.

The buttons Change Profile, Save, Save As allow you to create a new profile or edit the existing one.

The  buttons  Add  Group,  Edit  Group,  Delete  Group  allow  creating  new  route  groups  and  attach  routes  to

groups.
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1. Profiles

Profiles are used for quick switching between predefined bridging tables.

To add, modify or delete a profile, click Change Profile in the Bridging Configuration window.

If No Profile is selected, the created groups have no reference to a specific  profile.  The profile list  and buttons for

profile edition are not available in the Bridging Profiles window.

If  Select  Profile  is  enabled,  the  profile  list  is  available  for  editing  and  route  groups  can  be  assigned  to  the

selected profile.

In the Bridging Profiles window, click  Add to  create  a  new bridging  profile.  At  that,  the  Enter  Profile  Name

window opens. Use the Profile Name field to specify the profile name, click OK.

Left-click on the profile name in the Bridging Profiles window and click OK.
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In the list of groups, select Active check boxes near the route groups that should apply to the chosen profile.

As you finished editing the profile settings, click Apply to activate the current profile settings. At that,  the asterisk

character ("*") appears in front of the profile name.

Click Save to save the profile settings.
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To switch the profile,  click  Change  Profile  in the Bridging Configuration window, select  a profile from the list

and click OK. The Bridging Configuration window displays settings of the selected profile – active route groups.

Save As allows you to save a copy of the current profile with a new name.

2. Route Groups

To  create  a  new bridging  route  group  and  add  routes  to  it,  click  Add  Group  in  the  Bridging  Configuration

window.

In the Route Group window, specify name of the route group, add routes to the group and click OK.
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To save the changes in the route groups, click Apply.

Add routes to the group by clicking Add Route in the Route Group window. At that, the window for adding routes

opens up.

This  is  the  window where  you  create  routes.  Here  you  can  define  the  source  and  the  target  networks,  route

direction  (one-way  or  two-way),  the  source  radio  or  talkgroup  and  the  target  radio  or  talkgroup.  You  can  also

select the Route Type, which depends on the data type you want to patch.

Here you can find a detailed description how to configure routes of different types.

2.1. Configuring "All" Route Type

If you need to patch all  voice and data packets  from the source network  to the destination network,  select  All  in

the Route Type.

In this case you need to fill in the following fields:

Route Number – ordinal number of the route.

Source  Control  Station – select  any  of  the  added  control  stations  serving  as  a  source.  You  can  add  control

stations of various networks in SmartPTT Radioserver Configurator. 

Destination Control  Station – select  any of the added control stations  serving  as  a  destination.  You  can  add

control stations of various networks in SmartPTT Radioserver Configurator. 

Direction – allows you to select either one-way or two-way.
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Process Routed  Calls –  if  selected  the  call  which  is  already  routed  once  (by  one  route)  also  can  be  routed

another time by another route. It takes place only when several routes are added.

 Example:

 You can add all these routes without the Process Routed Calls check box selected:

 IPSC 01 slot 01 <---> IPSC 02 slot 01 

 IPSC 01 slot 01 <---> IPSC 03 slot 01

 IPSC 01 slot 01 <---> IPSC 04 slot 01

 IPSC 02 slot 01 <---> IPSC 03 slot 01

 IPSC 02 slot 01 <---> IPSC 04 slot 01

 IPSC 03 slot 01 <---> IPSC 04 slot 01

 Or, you can select the check box and create only three routes:

 IPSC 01 slot 01 <---> IPSC 02 slot 01

 IPSC 02 slot 01 <---> IPSC 03 slot 01

 IPSC 03 slot 01 <---> IPSC 04 slot 01

Warning!  Please  don’t  use  round  routes.  They  can  cycle  all  routes  and  lead  to  unstable  system

operation (for example, IPSC 01 slot 01 <---> IPSC 04 slot 01).

2.2. Configuring "Talkgroup" Route Type

In  order  to  patch  a  group  call,  select  Talkgroup  in  the  Route  Type.  Specify  the  source  and  the  destination

networks, and other parameters as if you were configuring the "All" Route Type. 
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The only difference is that for this route type you need to specify the groups' IDs, that is the source talkgroup ID in

the Source field and the destination talkgroup ID in the Target field.

2.3. Configuring "Subscriber" Route Type

Note:  This  route type is  not  supported in SmartPTT Basic,  since private calls  can't  be bridged  in  control  station

networks.  

To patch individual calls or text messages, select Subscriber in the Route Type field. 

Specify  the  source  and  the  destination  networks,  and  other  parameters  as  if  you  were  configuring  any  of  the

previous route types. 
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In the Source  field specify  the subscriber radio ID from  the  source  network.  The  Target  field  will  be  populated

automatically.  In this  case,  all  the subscribers  from the destination network  (see  Destination  Control  Station)

will be able to call to radio subscriber 123 and v.v. 

2.4. Configuring "Dynamic" Route Type

Note:  This  route type is  not  supported in SmartPTT Basic,  since private calls  can't  be bridged  in  control  station

networks.  

To patch private voice calls or text messages of the subscribers from the Subscriber Groups,  select  Dynamic in

the Route Type field. 
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In  the  Subscriber  Group  select  a  group,  which  was  added  in  Subscriber  Group  of  SmartPTT  Radioserver

Configurator.

Once  created,  the  routes  will  display  in  the  Route  Group  window.  Here  is  the  example  of  the  route  group

containing routes of three types (All, Group, Subscriber).

Activating Bridging Service

To  make  bridging  active  go  to  SmartPTT Radioserver  Configurator,  select  Bridging  in  the  tree  and  select  the

Active check box. Save the settings and restart the radioserver to apply the changes.

2.10  Conference Calls
The Conference  Call  is  a type  of  call  in  which  the  dispatcher  can  have  more  than  one  subscriber  of  different

types at a time. At that, all the participants of the conference call can hear and talk to each other.
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SmartPTT Dispatcher allows the dispatcher to organize conference calls  and to connect  the following subscriber

types:

Telephone subscribers

Other dispatchers using SmartPTT Dispatcher

Radio subscribers

Talkgroups

Note: To be able to make conference calls, the dispatcher must have the permission “Make conference calls”.

To  organize  a  conference  call,  click  the  Conference  Call  button   in  the  Main  Menu  bar  of  SmartPTT

Dispatcher. 

At that, the Conference Call window will appear.

To add a subscriber to the conference call,  unfold the the necessary  section and double-click  on the subscriber,

or use drag-and-drop.

The button  turns  off the sound of  the  conference  call.  At  that,  the  dispatcher's  microphone  is  turned  off

automatically. So the operator does not hear the conference call participants, and the participants cannot hear the
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dispatcher.

The button  turns off the operator's microphone.

Stop Conference Call – stops the current conference call. Should the radio subscriber make a call right  after the

conference call,  it  is  necessary  for him or her to wait  for a special tone notifying about  the end of the call.  If the

radio subscriber presses the PTT button before this tone, an incorrect phone call will be initiated.  

Starting  from  version  8.6  you  can  hold  conference  calls  with  radio  and  telephone  subscribers  without  enabling

Telephone Interconnect  in SmartPTT Radioserver Configurator.  For more information on how to do it,  see help  of

SmartPTT Radioserver Configurator (Telephone Calls). 

To finish the ongoing conference call with one of the participants, click the button  next to the participant. 

There is another way how to organize a conference call.

1. In  order  to  invite  an  external  dispatcher  or  a  telephone  subscriber,  click  the  buttons   or  

respectively. In the windows that opened select a dispatcher or a telephone subscriber, and click   
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Dispatcher:

Note: Only dispatchers from the Dispatcher List with status Active can be invited into the conference call.
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2. Use Action List to make a conference call. At that, the Conference  Call  window appears  and the call  is

initiated.

2.11  Help
The Help menu includes:

 Help.  Here you can find useful information on the system objects  and  functionality.  You  can  also  open
the SmartPTT Help file any time by pressing F1.

 About.  It  contains  information  on  the  application  version,  license,  and  the  third-party  software  used  in
development process.

Check for Updates.
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2.12  Remote Assistance
SmartPTT  contains  a  special  technical  support  tool  providing  remote  access  to  the  PC  to  resolve  possible

technical issues.

To  give  the  technical  support  engineer  remote  access  to  the  PC,  launch  SmartPTTRemoteAssistance.exe.

SmartPTTRemoteAssistance.exe window will show ID and Password which should be passed to the engineer.

Steps to follow to get remote assistance:

1. Launch Remote Assistance (Start > Programs > SmartPTT > Remote Assistance).
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SmartPTT Remote Assistance window

2. Pass Your ID and Password to the engineer who is going to provide technical support.

3. When the connection is established, you will see session window on the screen.
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4. Chat function can be used for communication with the engineer.

5. To stop the session click  .
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